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Standard Warranty

Standard Warranty 
Varitronics, LLC warrants the equipment and accessories comprising the 
VariQuest® Perfecta® 2400STP Poster Design System will be free from defects 
in material and workmanship for one (1) year from the date of customer purchase. 
Original serial number must appear on product. Removal of serial numbers will 
void this warranty and any equipment and accessories that have been altered or 
modified in any way and are not as originally purchased will void this warranty. 

Varitronics will at its option repair, replace or refund the purchase price of any 
accessories, supplies or equipment found to be defective under this warranty. 
THIS WARRANTY IS EXPRESSLY IN LIEU OF ALL OTHER WARRANTIES, 
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR WARRANTY OF FITNESS FOR A PARTICULAR 
PURPOSE. 

In the event of breach of this expressed warranty, or any other warranty, whether 
expressed or implied, Varitronics liability shall be limited to the remedy provided 
by the preceding paragraph. IN NO EVENT WILL VARITRONICS BE LIABLE 
FOR ANY DIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, NOR 
WILL VARITRONICS EVER BE LIABLE FOR BREACH OF WARRANTY, 
WHETHER EXPRESSED OR IMPLIED, INCLUDING ANY IMPLIED WARRANTY 
OF THE MERCHANTABILITY OR FITNESS, IN AN AMOUNT GREATER THAN 
THE PURCHASE PRICE OF THE PRODUCTS DESCRIBED BY THIS 
EXPRESSED WARRANTY. No agent, distributor, salesperson, wholesaler or 
retail dealer has authority to bind Varitronics to any other affirmation, 
representation or warranty concerning these goods.

FCC Notice 
This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. 
This equipment generates, uses and can radiate radio frequency energy and, if not installed and used 
in accordance with the instruction manual, may cause harmful interference to radio communication. 
Operation of this equipment in a residential area is likely to cause harmful interference in which case 
the user will be required to correct the interference at his own expense. 

CAUTION: Changes or modifications not expressly approved by the party responsible for
compliance could void the user’s authority to operate the equipment. 

EMC (Electromagnetic Compatibility Notice) 
This Class A digital apparatus meets all requirements of the Canadian Interference Causing 
Equipment Regulations. 
Cet appareil numerique de la classe A respecte toutes les exigences du Reglement sur le material 
broilleur du Canada.
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Technical Support

Technical Support
For technical assistance, please contact your authorized VariQuest dealer or the 
VariQuest Technical Support team:

• Email: techsupport@variquest.com
• Phone: 1-800-328-0585

Safety Information
Observe all warnings and instructions marked on the product. Follow these 
precautions to ensure proper use and handling of the printer:

• Use the power-supply voltage specified on the label. Avoid overloading the
printer’s electrical outlet with multiple devices.

• Do not disassemble or repair the printer. Contact your authorized VariQuest®
Dealer or the VariQuest Technical Support team for service.

• Use only the electrical cord supplied with the printer. Do not damage, cut, or repair
the power cord. A damaged power cord can cause fire or electric shock. Replace a
damaged power cord with an approved power cord.

• Do not allow metal or liquids (except those used in Cleaning Kits) to touch internal
printer parts. Doing so may cause fire, electric shock, or other serious hazards.

• Do not handle the power cord with wet hands. Doing so may cause electric shock
hazard.

• Do not set heavy objects on the power cord; do not bend the cables or force them
into contorted positions.

• Insert the power cord securely and completely into the wall socket and equipment
inlet. A poor connection can cause a fire or an electric shock hazard.

• Power off the printer and unplug the power cord from the power outlet in any of the
following cases:

• When placing your hands inside the printer.
• If there is smoke or an unusual smell coming from the printer. or if the

printer is making an unusual noise not heard during normal operation.
• If a piece of metal or a liquid (not part of cleaning and maintenance

routines) touches internal parts of the printer.
• During an electrical (thunder/lightning) storm or during a power failure.
• The power cord or plug is damaged, the equipment has been dropped or

the equipment is not operating normally.

CAUTION!CAUTION!
Two people are required whenever handling the printer. Take care to avoid back strain 
and/or injury. Use of personal protective equipment is recommended.
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Other

Other

Varitronics and Hewlett-Packard (HP) worked together to create the VariQuest® 
Perfecta® 2400STP Poster Design System. Perfecta is a compact and friendly 
printer designed specifically for schools. Some features have been optimized for 
school use. For additional features, contact our Technical Support team.

The information in this manual is from the HP User Guide. Not all features are 
available with the VariQuest® Perfecta® 2400STP Poster Design System.
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1 Introduction

This chapter provides an overview of the VariQuest® Perfecta® 2400STP Poster Design 
System. The following information is contained in this chapter:

• “Features” on page 1-2
• “Main Components” on page 1-3
• “Printer Software” on page 1-8
• “Mobile Printing and Web Services” on page 1-9
• “Turn Printer On and Off” on page 1-10
• “Internal Prints” on page 1-11
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Features

Features
Your printer is a color inkjet printer designed for printing high-quality images on 
paper up to 24 inches wide. It also has an integrated color scanner capable of 
scanning images up to 24 inches wide. 

Some major features of the printer are:

• Print resolution of up to 2400 × 1200 dpi, using the Best print-quality option, the
Maximum Detail option and photo paper.

• Scan resolution of up to 600 dpi, in RGB color with 24 bits per pixel, or
grayscale with 8 bits per pixel, or black and white with 1 bit per pixel.

• The printer can be controlled from its front panel or from a remote computer
using the Embedded Web Server or the HP Utility.

Note: Throughout this manual, “HP Utility” refers to the HP Utility for Windows.

• Touch-sensitive front panel in color, with an intuitive graphical user interface.
• Supports USB, Ethernet, or WiFi connection.
• Mobile Printing and scanning includes Web-connected features such as

automatic firmware upgrades and HP ePrint.
• Hi-Speed USB host port for connecting a USB flash drive.
• Handles roll and cut-sheet paper, with a multi-sheet tray.
• Color emulations, see “Printer Emulation” on page 4-12.
• Economode for printing economically.
• Ink and paper usage information available from the Embedded Web Server,

see “Access the Embedded Web Server” on page 2-18.
• Supplies information, troubleshooting, and firmware updates available from the

HP Utility, see “Access the Printer Utility” on page 2-20
• Access to the online HP Support Center.
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Main Components
Front View

Main Components

Front View

Note: Image is intended to show component placement only and may not be an 
exact representation of your printer.

1 Multi-sheet tray extenders 7 Bin
2 Ink Cartridges 8 Output Platen
3 Ink Cartridge Cover 9 Front Panel
4 Printhead Door 10 Scanner Cover
5 Printhead 11 Front Window
6 Output Tray Extender
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Main Components
Rear View

Rear View

Note: Image is intended to show component placement only and may not be an 
exact representation of your printer.

1 Roll Cover 3 Multi-sheet Tray
2 Communication Ports
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Main Components
Communication Port

Communication Port

Note: Image is intended to show component placement only and may not be an 
exact representation of your printer.

1 Ethernet Port
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Main Components
Front Panel

Front Panel
The front panel, located on the front left of the printer, is a touch-sensitive screen 
with a graphical user interface. It gives you complete control of your printer: from 
the front panel, you can print, scan, view information about the printer, change 
printer settings, perform calibrations and tests, and so on. The front panel also 
displays alerts (warning and error messages) when needed. 

The front panel has a large central area to display dynamic information and icons. 
At the top of the central area there is a dashboard that displays the Home screen 
icons. To interact with these icons swipe down the dashboard status to access the 
Dashboard.

On the left and right sides of the screen you can see up to four fixed icons at 
different times. Normally they are not all displayed at the same time.

Close to the front panel is the Power key , with which you can turn the printer 
on or off. The key is illuminated when the printer is on. It flashes when the printer 
is in transition between on and off.

Note: Information about specific uses of the front panel can be found throughout 
this guide.

Left and Right Fixed Icons 
Shows wireless connection status: If 
the blue light is shining, the wireless 
connection is active.

Help: Press to view help about the 
current screen.

Home: Press to return to the home 
screen.

Back: Press to go back to the previous 
screen.
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Main Components
Front Panel

Home Screen Dynamic Icons
The following icons are displayed only on the Home screen. 

If the printer is left idle for some time, it goes into sleep mode and switches off the 
front-panel display.

To change the elapse time before sleep mode:

1. Swipe down the dashboard and touch .
2. Touch Printer Setup > Sleep Mode.
3. Set a time between 5 and 180 minutes.
The printer wakes from sleep mode and switches on the front-panel display 
whenever there is some external interaction with it.

Paper Tab Icons
Roll Paper: Touch to load, unload, and 
change options for roll paper

Single Sheet Paper: Press to load, unload, 
and change options for single sheets.

Multi-Sheet Tray: Press to change 
options for the multi-sheet tray, or to 
activate it.

Note: Active paper source is indicated by a larger icon, with a white tick in a blue circle .

Dashboard Icons
Tools: Touch to change printer settings. Scan: Touch to eject scanned original.

Ink: Touch to view ink formation. Printhead: Touch to view printhead 
information.

Mobile Printing: Touch to view 
information and configure ePrint to print 
from a computer or mobile device sending 
an email to the printer.

WiFi Direct: Touch to view information 
about wi-fi direct.

Connectivity: Touch to view connectivity 
status information and to perform network 
configuration. If a network cable is 

connected,  is displayed instead.

Note: You cannot use wireless and wired 
network connections simultaneously.
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Printer Software
Front Panel

Printer Software
The following software is provided with your printer:

• The GL/2 and RTL driver for Windows
• The Embedded Web Server (see “Access the Embedded Web Server” on

page 2-18). Allows you to:
- Manage printer from a remote computer.
- View status of ink cartridges, printhead, and paper.
- Access the Support Center.
- Update printer's firmware.
- Perform alignments and troubleshooting.
- Change various printer settings.
- Manage e-mail notifications.

• Utility (see “Access the Printer Utility” on page 2-20.). Allows you to:
- Manage printer from a remote computer.
- View status of ink cartridges, printhead, and paper.
- Access the Support Center.
- Update the printer's firmware, see “Software and Firmware Updates” on

page 5-14.
- Launch the Embedded Web Server.

Note: New versions of all printer software can be expected to appear from time to 
time. In some cases, when you receive your printer there may already be later 
versions available.
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Mobile Printing and Web Services
Enable eMail Printing

Mobile Printing and Web Services
Your printer can be connected to the Internet and the Web, providing various 
benefits:

• Automatic firmware updates (see “Firmware Updates” on page 5-14).
• Print on ePrinters from almost anywhere.
• Print on ePrinters from almost any device, including smart phones and tablet 

computers.

Note: To take advantage of these benefits, your printer must be connected to the 
Internet.

Mobile Printing
Mobile printing lets you print straight from your smartphone or tablet in just a few 
simple steps wherever you are; using your mobile device OS or sending an email 
to your printer with PDF, TIFF and JPEG attachments.

• iOS-Apple printing is enabled through Airprint.
• For Android printing, install the HP Print Service App from Google Play (if not 

already installed on your mobile device). Go to: https://play.google.com/store/
apps/details?id=com.hp.android.printservice&hl=en

• You can also download HP All-in-One Remote for enhancing printing capabilities 
and enabling Scanning and Sharing from the smartphone or tablet. Go to: 
mailto:https://itunes.apple.com/us/app/hp-all-in-one-printer-
remote/id469284907%3Fmt=8

• To print by email go to HP ePrint, enable the service and retrieve the printer’s 
email address.

Enable eMail Printing
1. Make sure that your printer is correctly connected to the Internet.
2. Enable Web Services during initial setup of the printer, or later by 

touching  on the home screen and following the instructions on the front 
panel. The printer may need to restart if it has updated its firmware.

3. Optional: Activate your account by clicking the activation link that you will 
receive by email. 

Note: If you don’t see the message, remember to check your junk email folder. 

4. Optional: If you are the printer administrator, log in at HP Connected 
(http://www.hpconnected.com) to customize your printer’s email address or 
manage printer security for remote printing.



1-10 VariQuest® Perfecta® 2400STP User’s Guide

Turn Printer On and Off
Enable eMail Printing

Turn Printer On and Off
1. To turn the printer on or off, press the Power key on the front panel.

2. To store the printer for a long period, or the Power key does not work, unplug
the power cord.

3. To reapply power, plug in the power cord.

When the printer is powered back on, it takes about three minutes to initialize
and check and prepare the printhead. Preparing the printhead takes about 75
seconds.

Note: When the printer has been idle for a certain period of time, it saves power by 
going into sleep mode. However, any interaction with the printer's front-panel 
display, or sending a new job to print, returns it to active mode and it can resume 
printing immediately. To change the sleep mode time, see “Change Sleep Mode 
Setting” on page 2-20.

[2]
[3]
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Internal Prints
Enable eMail Printing

Internal Prints
Internal prints give various kinds of information about your printer and can be 
requested from the front panel.

Before requesting any internal print, check that the printer and the paper are 
ready for printing. The loaded paper should be at least A4 portrait—8.27 inches 
wide—otherwise the print may be clipped.

To print any internal print:

1. Swipe down the dashboard and touch .
2. Scroll down and touch Reports.
3. Select the report you want from the following list:

• Demo Prints (show some of the printer capabilities)
- Drawing Demo
- Rendering Demo
- GIS Map

• User Info Prints
- Printer-Status Report
- Print-quality Report
- Network Configuration Page
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Internal Prints
Enable eMail Printing

This page is intentionallly left blank.
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2 Printer Setup

This chapter provides an setup and personalization of the VariQuest® Perfecta®

2400STP Poster Design System. The following information is contained in this chapter:

• “Choosing Connection Method” on page 2-2
• “Connecting Design Center 2300 Software to Perfecta 2400STP Printer” on page 2-4
• “Mobile Printing from an iOS Device” on page 2-12
• “Setting Up the Printer” on page 2-15
• “Personalizing the Printer” on page 2-18
• “Manage Perfecta 2400STP Printer Security” on page 2-26
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Choosing Connection Method

Choosing Connection Method

Note: The speed of any network connection depends on all components used in the 
network, which can include network interface cards, routers, switches and cables. If 
any one of these components cannot operate at high speed, you will have a low-speed 
connection. The speed of your network connection can also be affected by the total 
amount of traffic from other devices on the network.

Wireless connection can be affected by the location of the network router and the 
device. In order to improve the wireless connection:

1. Position the wireless access point in a more central position of the working
place as shown in figures 1 and 2. Try place away from dense materials.

Note: Metal, concrete, double thick walls are the hardest to penetrate, wood 
and plasterboard are easier. Consider these when positioning the printer.

2. Change the wireless channel to one that’s not being used, preferably
1, 6 or 11 as these are non-overlapping channels.

3. Extend the range of the wireless network by using a simple wireless extender
or adding more wireless access points as shown in figures 3 and 4.

Do you want access to the internet/your network?

Wired or wireless 
connection?

Configure using
Wi-Fi Direct
Connection.

Configure using
School Network 

using Wi-Fi

Use Direct Wired 
Connection. 
Requires an 
additional 

ethernet cable 
and instructions 
are in the Users 

Guide.

Configure using 
School Network 
Using Network 

(Ethernet) Cable.
Requires an additional 

ethernet cable and 
instructions are in the 

Users Guide.

Do you want your printer
on your network?

No

Wire
les

s
Eas

y

YeWire
les

s
s

W
fficu

ired

Di
lt

Wi edNo
r

Yes

Method 4 Method 3Method 1 Method 2



Connecting Design Center 2300 Software to Perfecta 2400STP Printer
Configure DC2300 & Perfecta 2400STP via Wi-Fi Direct

Connecting Design Center 2300 Software to 
Perfecta 2400STP Printer (Methods 1 - 4)

Before printing from the Design Center to the Perfecta 2400STP, you must first 
set up the Design Center software and the Perfecta 2400STP printer. 

Configure DC2300 & Perfecta STP Series via Wi-Fi Direct - 
Method 1
Note: This is a direct wireless connection and does not use any external networks.

1. On the Perfecta® STP Series Printer, setup your Wi-Fi Direct connection.

Turn on Wi-Fi Direct:
a. Drag down or tap the top menu

b. Touch      on the top left

c. In the Setup menu, select Wi-Fi Direct

d. In the Wi-Fi Direct Settings menu, toggle Wi-Fi- Direct to ON.

e. In the Connection Method, choose Manual, then touch      to exit.

To Verify Wi-Fi Direct is Enabled:
a. Drag down or tap the top menu

b. On the info menu, verify the printer’s Wi-Fi Direct connection is enabled by scrolling
up or down to find the correct printer (e.g., Direct-xx HP DesignJet T830). If Wi-Fi
Direct is enabled, the Wi-Fi Direct network name and password will display.

2. Start the DC2300. The VariQuest® Software launches automatically.

3. Immediately connect the DC2300 to the Perfecta STP Series
Printer with Wi-Fi Direct Connection (i.e., DIRECT-xx HP DesignJet
T830) using the Windows Wireless Network utility on the bottom
right of your screen.

Note: Enter the Password located on the Info menu of your printer’s 
control panel into the Security Key text window in your Windows 
Wireless Network Utility.
Attention: You may need to minimize the VariQuest Software in order 
to see the utility.

4. Once connected, focus your attention back onto the VariQuest® Software.

5. In the Welcome screen, touch OK, follow the setup options by going under Workroom 
Assistant > Setup > Output Devices - then select the Perfecta STP Series by checking 
the box and clicking OK.

6. You will then be prompted to enter your school mascot and name. Once you have 
completed entering this information, click OK and you will be taken back to the Menu 
screen where the Perfecta STP Series icon will be present.

7. Now, go back into Workroom Assistant > Setup > Network Connection, then select the 
Perfecta STP Series printer. (Make sure you are running the software as an administrator 
to access the Network Connection Utility.)

8. On the right side under Network Printer Settings select Wi-Fi Direct. Select OK.

9. You are now able to print from the DC2300 to the Perfecta STP Series Printer.
2-4 VariQuest® Perfecta® 2400STP User’s Guide
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Configuring DC2300 & Perfecta 2400STP via a Network

Configure via School Network Using Wi-Fi - Method 2

Both the DC2300 and Perfecta® STP Series printer must be connected to your local network 
before starting this process. 

1. On the Perfecta STP Series, swipe down on the dashboard or tap the top menu, touch
on the top left, then scroll down and touch Network setup > Wireless settings.

2. Select Wireless Setup Wizard. The printer will search for wireless routers.

3. Choose a Network Name, then enter the Password. Touch Apply when done.

4. In the Connection Successful menu, touch OK.

5. Start the DC2300. The Design Center Software launches automatically.

6. In the Welcome screen, touch OK, follow the setup options by going under Workroom 
Assistant > Setup > Output Devices - then select the Perfecta STP Series by checking 
the box and clicking OK.

7. You will then be prompted to enter your school mascot and name. Once you have 
completed entering this information, click OK and you will be taken back to the Menu 
screen where the Perfecta STP Series icon will be present.

8. Now, go back into Workroom Assistant > Setup > Network Connection, then select the 
printer you would like to connect with the DC2300. (Make sure you are running the 
software as an administrator to access the Network Connection Utility.)

9. On the right side under Network Printer Settings select School Network where it will then 
prompt you to enter your Perfecta STP Series IP address. Once entered, select OK and 
OK again (Find the printers IP address by dragging down or tapping the top menu of the 
printer screen and scrolling up or down on the Info menu. The IP address will be present 
2nd from the top).

10.  Go back to the Menu screen and the Perfecta STP Series icon should be present, so you 
are able to print from the DC2300 to the Perfecta STP Series printer.
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School Network Using Network (Ethernet) Cable - Method 3

Both the DC2300 and Perfecta® STP Series printer must be connected to your local network 
before starting this process. 

• On the DC2300, connect to the local network/wifi using the windows wireless network
utility in the bottom right of your scree,

• On the Perfecta STP Series printer, connect the Ethernet from the backside of the
printer into the wall

1. Start the DC2300. The Design Center Software launches automatically.

2. In the Welcome screen, touch OK, follow the setup options by going under Workroom 
Assistant > Setup > Output Devices - then select the Perfecta STP Series by checking the 
box and clicking OK.

3. You will then be prompted to enter your school mascot and name. Once you have completed 
entering this information, click OK and you will be taken back to the Menu screen where the 
Perfecta STP Series icon will be present.

4. Now, go back into Workroom Assistant > Setup > Network Connection, then select the 
printer you would like to connect with the DC2300. (Make sure you are running the software 
as an administrator to access the Network Connection Utility.)

5. On the right side under Network Printer Settings select School Network where it will then 
prompt you to enter your Perfecta STP Series IP address. Once entered, select OK and OK 
again (Find the printers IP address by dragging down or tapping the top menu of the printer 
screen and scrolling up or down on the Info menu. The IP address will be present 2nd from 
the top).

6. Go back to the Menu screen and the Perfecta STP Series icon should be present, so you are 
able to print from the DC2300 to the Perfecta STP Series printer.

Connecting Design Center 2300 Software to Perfecta 2400STP Printer
Configuring DC2300 & Perfecta 2400STP via school network using an ethernet cable
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Connecting Design Center 2300 Software to Perfecta 2400STP Printer
Connect DC2300 & Perfecta 2400STP without a network via a direct wired Ethernet connection

Connect DC2300 & Perfecta 2400STP without a Network via a  
Direct Wired Ethernet Connection (Part 1)- Method 4

Configuring The Design Center 2300 

1. Press the Windows button and click on the Settings wheel
2. On the Windows Settings panel select Network & Internet
3. On the left side, select Ethernet
4. Click on Change adapter options

5. Right click Ethernet (whichever one is connected) and choose Properties.

6. Select Internet Protocol Version 4 (TCP/IPv4), then click Properties.

7. Select Use the following IP Address and enter the following:
- IP Address: 192.168.1.2
- Subnet mask: 255.255.255.0

8. Press OK.

ATTENTION: If you have the 9.0 version of the VariQuest software you may skip this page 
and proceed to the next page, but if you have 8.0 or less, then you must follow these steps
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Connecting Design Center 2300 Software to Perfecta 2400STP Printer
Connect DC2300 & Perfecta 2400STP without a Network

Configuring Perfecta 2400STP Printer 

1. Touch  Settings at the upper left corner of the screen.

2. On the Info screen, touch  Settings again.

3. In the Setup menu, select Network Setup.

Connect DC2300 & Perfecta 2400STP without a Network via a  
Direct Wired Ethernet Connection (Part 2)- Method 4
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Connecting Design Center 2300 Software to Perfecta 2400STP Printer
Connect DC2300 & Perfecta 2400STP without a Network

4. In the Connected menu, select Ethernet Settings.

5. In the Ethernet Settings menu, select Advanced Settings.

6. In the Advanced Settings menu, set IPv6 to OFF.

Note: Select Yes to turning off this warning shown below
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Connecting Design Center 2300 Software to Perfecta 2400STP Printer
Connect DC2300 & Perfecta 2400STP without a Network

7. In the Advanced Settings menu, select IP Settings.

8. In the IP Settings menu, select Manual.

9. Select OK on any information screens that display.
10. In the Manual IP Settings menu, select IP Address.



VariQuest® Perfecta® 2400STP User’s Guide 2-11

Connecting Design Center 2300 Software to Perfecta 2400STP Printer
Connect Perfecta 2400STP to DC2300 via Ethernet Cable

11. On the keyboard, enter 192.168.001.005, then touch Done.

12. In the Manual IP Settings menu, select Subnet Mask.

13. On the keyboard, enter 255.255.255.0, then touch Done and Apply.

1. Connect one end of an Ethernet LAN cable to the
Perfecta 2400STP.

2. Connect other end of Ethernet LAN cable to the
DC2300.

3. Open 9.0 VQ SW by right clicking on SW icon and
running as administrator.

4. Click on “Workroom assistant” tab.
5. Click on “Setup”.
6. Click on “Network Connection”.
7. Place checkmark by VariQuest Perfecta STP Series.
8. Click on “Hard Wired”.  Answer yes to advisory.
9. You will now be able to open the Perfecta STP module

and print via ethernet cable.

Connect DC2300 & Perfecta 2400STP without a Network via a  
Direct Wired Ethernet Connection (Part 3)- Method 4

Configuring The VariQuest Design Center Software 
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Mobile Printing from an iOS Device
Print via Wireless Internet using iOS Device

Mobile Printing from an iOS Device
You can print directly from your smartphone or tablet in just a few simple steps 
wherever you are using your mobile iOS device. Method 1 is for printing from a 
mobile device when both your printer and device are connected to the internet. 
Method 2 is for printing without connecting to a wireless network.

Note: Mobile printing is also supported for Android depending on the version of 
your device. To print from Android™ devices, download the HP Print Service 
Plugin app from Google Play.

Print via Wireless Internet using iOS Device
1. Connect the Perfecta 2400STP printer and your device to the local internet.

Make sure your mobile device has WiFi enabled.

Note: The mobile device and printer must be connected to the same internet.

2. On your mobile device, choose the document you want, then touch Print.
3. Select your Printer (HP DesignJet T830 MFP (XXXXXX).

4. Select paper size and other options (e.g., paper size, color, black & white).

Note: The print will automatically size itself to how it was designed. To print on 
the size of the loaded paper, you must select it. 

5. When done, touch Print. The document will be sent to the Perfecta 2400STP.



VariQuest® Perfecta® 2400STP User’s Guide 2-13

Mobile Printing from an iOS Device
Print without Wireless Network using iOS Device

Print without Wireless Network using iOS Device
To connect the printer to your phone without using a wireless network, you must 
use the Direct Printing option.

1. On the printer, select  at top of screen. The Info menu will indicate the 
printer is not connected.

2. Select Setup and choose Wi-Fi Direct.

3. In Wi-Fi Direct Settings menu, make sure Wi-Fi Direct is ON. The Connection
Method will indicate Manual and the printer will change to automatic.

4. When the Wi-Fi Direct Settings change to Automatic, touch  to display the 
Info menu with a list of available printers. Note the password for later.
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5. In the Choose A Network list, select the printer (e.g., e.g., DIRECT-xx-HP-
DesignJet) and when prompted, enter the password from the Info screen.

6. On your mobile device, select a document, then touch Print and select your
Printer (HP DesignJet T830 MFP (XXXXXX).

7. Select the paper size and other options you want (e.g., paper size, color, black
& white).

Note: The print will automatically size itself to how it was designed. To print on 
the size of the loaded paper, you must select it. 

8. When done, touch Print. The document will be sent to the Perfecta 2400STP.
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Setting Up the Printer

Introduction
This section describes various printer settings that the printer administrator may 
want to control as soon as a new printer is assembled and ready for use.

Automatic Firmware Update
The printer can automatically check for a firmware update periodically (see 
“Automatic Firmware Update” on page 2-15). Without an update, some Web 
Services may not be available. The Enable Web Services process includes the 
option to turn on automatic firmware updates from the printer's front panel or 
Embedded Web Server.

Turn Email Notifications On and Off
To receive email notifications from the printer, you must configure the email 
server. To configure the email server using the Embedded Web Server, select 
Settings > Email alerts and fill in the following fields:

• SMTP server: The IP address or hostname of the outgoing mail server
(SMTP) that will process all email messages from the printer. If the mail server
requires authentication, email notifications will not work.

• Printer email address: Each email message sent by the printer must include
a return address. This does not need to be a real, functional email address, but
should be unique so that message recipients can identify the printer that sent it.

Note: You can turn specific email notifications on or off by selecting Notifications 
from the Tools tab of the Embedded Web Server.
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Turn Alerts On and Off
Printer alerts warn you when there is a printer problem that you can correct by 
taking action, or when one of your printing jobs changes its status. The alerts are 
displayed by the printer's front panel, by the printer utility, by the printer driver and 
by the Embedded Web Server. 

You can change the alert settings in various ways to display all, some, or none of 
the available alerts.

To access alert settings under Windows:

1. In the Tools menu, select Alert Settings.
2. In any alert page displayed in the printer utility, select Alert Settings.
3. Right-click the system tray icon of the printer utility, and select Alert Settings.
4. In the Alert Settings window, use the Alerting slider to turn off alerts.

Note: You can choose when, if ever, to display critical or non-critical alerts.
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Control Access to Embedded Web Server
To prevent users from modifying important device settings, you can set a 
password in the Embedded Web Server, so that users without the password can 
see only the Information tabs. Once set, the password is required to view or 
change any parameters in the other tabs.

Set Windows Driver Preferences 
You can change some default settings in your printer driver according to your own 
preferences (e.g., to set color emulation or paper-saving options). See the 
following example, for Windows 7 systems:

To change windows driver preferences:

1. On the computer, press Start.
2. Click Devices and Printers.
3. Right-click your printer's icon and select Printing preferences.
4. Make the desired changes, then click OK. Any settings you change in the

Printing Preferences window will be saved as default values.

Setup Web Services
Before using Web Services, some setup is required on your printer and your 
computer.

1. Verify that your printer is correctly connected to the Internet.

2. To connect to a wireless network, swipe down the dashboard and touch .
3. Scroll down and touch Web Services.

Note: During the process, you will have access to an Automatic firmware 
update service. To ensure the best performance, we recommend that this 
service is enabled and the unit is updated with the latest firmware available.

4. Optional: If you are the printer administrator, log in at HP Connected
(http://www.hpconnected.com) to customize your printer’s email address or
manage printer security for remote printing.

Congratulations, you now have completed Web Services setup. ePrint is ready to 
use.
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Personalizing the Printer

Change Front-Panel Display Language
There are two possible ways to change the language of the front-panel menus and 
messages.

If you understand the current language:

1. Swipe down the dashboard, then press .
2. Press Preferences > Language.
3. When the language select menu displays, press your preferred language.

Access the Embedded Web Server
The Embedded Web Server enables you to manage your printer remotely using 
an ordinary Web browser running on any computer.

To access the Embedded Web Server, you must have a TCP/IP connection to 
your printer. 

The following browsers are known to be compatible with the Embedded Web 
Server:

• Internet Explorer 10 and later
• Mozilla Firefox 35 and later
• Safari 8.x for Yosemite (OSX v10.10), Safari 7.x for Mavericks (OSX v10.9) and

Safari 6.x for Mountain Lion (OSX v10.8) and later
• Google Chrome 40 and later

To access the Embedded Web Server:

1. Open your Web browser.
2. Type the IP address of your printer. You can see your printer's IP address on

the front panel by pressing  or .
3. If you followed these instructions but failed to get through to the Embedded

Web Server, see "Cannot access the Embedded Web Server" in
“Troubleshooting” on page 6-1.
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Change Embedded Web Server Language
The default language for the Embedded Web Server is the language you  
selected for your browser. If this language is not supported by the Embedded 
Web Server, the Embedded Web Server will appear in English; however, you can 
change it to any supported language.

The languages supported by the Embedded Web Server are English, Portuguese, 
Spanish, Catalan, French, Italian, German, Polish, Russian, Simplified Chinese, 
Traditional Chinese, Korean, and Japanese. 

There is an option at the bottom of the screen to change the language.
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Access the Printer Utility
The Printer Utility enables you to manage your printer from a computer with a 
USB, TCP/IP, or WiFi connection.

To access the printer utility:

1. Start the Printer Utility from your desktop shortcut or from Start > All
Programs> HP > HP Designjet Utility > HP Designjet Utility. This launches
the Printer Utility, showing the printers installed on your computer.

2. When you select your printer in the left pane, everything that appears in the
right pane is specific to that printer.

Change the Language of the Printer Utility
The HP Utility can work in the following languages: English, Portuguese, Spanish, 
Catalan (Windows only), French, Italian, German, Dutch, Russian, Simplified 
Chinese, Traditional Chinese, Korean, and Japanese. The language will be 
adjusted to your regional language settings as defined in the Windows Control 
Panel.

Change Sleep Mode Setting
If the printer is left on but unused for a certain period of time, it automatically goes 
into sleep mode to save power. 

To change the sleep-mode settings:

1. Swipe down on the dashboard, then touch .
2. Scroll down the menu and touch Sleepmode.
3. Select the wait time you want, then press OK.

Note: You can set the time from 5 to 180 minutes. The default time is 5 minutes.
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Change Auto-Off Setting
You can use the printer's auto-off feature to turn the printer off automatically. For 
example, setting it to 2 hours would turn the printer off after 2 hours of inactivity. In 
this way, you can save more energy.

CAUTION!CAUTION!
The auto-off feature is automatically disabled when the printer is connected to a 
network, to avoid inconveniencing network users.

To set printer to turn off automatically:

Note: If you are using a USB connection, you can set the printer to turn itself 
off completely after 2 to 12 hours of inactivity. 

1. At the front panel, swipe down the dashboard, then press .

2. Scroll down the menu and touch Auto power off.

Change Front-Panel Display Brightness
To change the brightness of the front-panel display:

1. Swipe down the dashboard, then touch .

2. Scroll down the menu and touch Preferences > Screen Brightness.
3. Select the brightness value you want, then touch Done.
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Configure Network Settings
You can view and configure the network settings from the Embedded Web Server, 
the Printer Utility or the front panel.

• Embedded Web Server: Select the Network tab.
• Printer Utility: Access the Embedded Web Server through the Printer Utility.

• Front Panel: Swipe down the dashboard, touch , then scroll down the
menu and touch Network setup.

The following options are available:

• Enable/Disable Wireless: Turns the wireless connection on or off.
• Wireless Setup Wizard: Provides an easy way to connect to a wireless

network.
• WiFi-Protected Setup: Allows you to set up a connection with a wireless

network using WPS (pushbutton or pin) encryption.
• Network Summary: Displays information about the wired or wireless network
• Print Wireless Network Test: Runs diagnostic tests of wireless connectivity
• Print Network Configuration
• Advanced Setup:

- Select I/O Timeout: Sets the time that the printer will wait for the driver
to send a job to the printer once the connection has been opened. Values
range from 30 seconds to 30 minutes.

- Link Speed: Sets the speed at which data are transmitted over the
network. The default is Automatic.

- IP Settings: Allows you to view or change the IP address, subnet mask,
default gateway, and DNS address.

- Hostname: Allows you to change the hostname.
• Restore Network Defaults
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Configure Firewall Settings
Firewall features provide network-layer security on both IPv4 and IPv6 networks. 
The firewall provides simple control of IP addresses that are allowed access.

Note: In addition to firewall protection at the network layer, the printer also supports 
open secure sockets layer (SSL) standards at the transport layer for secure client-
server applications, such as clientserver authentication or HTTPS Web browsing.

For firewall operation on the printer, you must configure a firewall policy to apply 
to specified IP traffic. Firewall policy pages are accessed through the Embedded 
Web Server and displayed by your Web browser. After a policy is configured, it is 
not activated until you click Apply in the Embedded Web Server.

Creating and Using Firewall Rules
Firewall rules allow you to control IP traffic. Use firewall rules to allow or drop IP 
traffic based on IP addresses and services.

Enter up to ten rules, each rule specifying the host addresses, services, and the 
action to take for those addresses and services.

Create a Firewall Rule
1. Open the Embedded Web Server.
2. Click Settings tab, then Firewall Rules.
3. Click New.
4. Follow the onscreen instructions.

Note: After you click Apply, the connection to the Embedded Web Server 
might be temporarily disrupted. If the IP address was unchanged, the 
Embedded Web Server connection will be enabled again. However, if the IP 
address was changed, use the new IP address to open the Embedded Web 
Server.

Change Priority of Firewall Rules
1. Open the Embedded Web Server.
2. Click Settings tab, then Firewall Rules Priority.
3. Select the priority from the Rule Precedence list, with 10 having the highest

priority and 1 having the lowest priority.
4. Click Apply.
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Change Firewall Options
1. Open the Embedded Web Server.
2. Click Settings tab, then Firewall Options.
3. Change the desired options then click Apply.

Note: After you click Apply, the connection to the Embedded Web Server 
might be temporarily disrupted. If the IP address was unchanged, the 
Embedded Web Server connection will be enabled again. However, if the IP 
address was changed, use the new IP address to open the Embedded Web 
Server.

Reset Firewall Settings
To reset firewall settings to factory defaults, restore the printer’s network settings.

Limitations to Rules, Templates, and Services
When creating firewall rules, note the following limitations to rules, templates, and 
services.

Item Limit (Maximum Number)
• Rules: 10 (one default rule)
• Address Templates: 12
• User-defined Address Templates: 5
• Services added to a User-defined Service Template: 40

Note: The predefined All Services template is not subject to this limitation and 
includes all services supported by the print server.

• Services added to the Policy: 40

Note: For a given rule, only one address template and one service template 
can be added.

• Service Templates in the Policy: 10
• User-defined Custom Service Templates: 5
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Reset Network Settings
To reset the administrator password and network settings, swipe down on the 
dashboard, touch , then scroll down and touch Network setup > Restore 
Network Defaults.

Note: Print the network configuration page and check that the network settings 
have been reset.

Note: Resetting the printer’s network settings also resets the printer’s firewall 
settings.

Change Printer Email Address
You can change your printer's email address at the HP ePrint Center.
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Manage Perfecta 2400STP Printer Security
When you set up Web Services, the printer is in unlock mode. In unlock mode, 
anyone who knows your printer's email address can print to your printer by just 
sending a file to it. You should be careful about giving out your printer's email 
address, as everything sent to that address may be printed on your printer. See 
“Advanced Security Options” on page 2-26 for alternate security methods.

If you are the printer administrator, you can manage printer security or change 
your printer status to lock mode by visiting the ePrint Center where you created 
your ePrint account. You can also customize your printer's e-mail address and 
manage print jobs from there. 

Advanced Security Options
There are 3 methods you can use to secure your printer from unintended users 
printing to your device: 1) Connect via Wi-Fi Direct, 2) Turn off Broadcast Mode 
and connect to the printer manually, and 3) Connect the DC2300 and Perfecta 
2400STP to a private network.

Connect via Wi-Fi Direct
Connecting via Wi-Fi Direct provides a printer-generated password that you must 
know or have access to before you can print to the 2400STP printer. See 
“Configure DC2300 & Perfecta 2400STP via Wi-Fi Direct” on page 2-5 for details.

Turn off Broadcast Mode
When your printer is connected to the internet, it automatically "broadcasts" its 
name on the network list. You can turn this option off to prevent unauthorized 
users from connecting and printing to this device.



VariQuest® Perfecta® 2400STP User’s Guide 2-27

Manage Perfecta 2400STP Printer Security
Advanced Security Options

To turn off Broadcast mode:

1. On the Perfecta 2400STP, touch  at top left. Note the IP address and 
Password (listed 2nd from top).

2. In your Browser, enter IP Address 192.168.223.1, then select Network tab.

3. On the Network tab, select Wi-Fi Direct.
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4. Select Status.

5. In the Wi-Fi Direct menu, select Edit Settings.
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6. Under Connection Method, select Advanced.

7. Under Advanced Settings, select the button Do not broadcast the Wi-Fi
Direct name, then click Apply.

8. At the prompt indicating the changes were updated successfully, click OK.

Connect via a Private Network
You can connect your Perfecta 2400STP printer and the Design Center system to 
a private network that is not accessible to students and other unauthorized users. 
See your IT Specialist for connection and setup details.
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Manually Connect to a Wireless Network
With Broadcast network off, you can manually connect to the printer.

1. From the Control Panel, go to Network and Sharing Center.
2. Select Change advanced sharing settings.

3. In Manage Wireless Networks, click Add.
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4. In the Add menu, select Manually create a network profile.

5. From the Security type drop-down list, select WPA2-Personal.
6. Click the box for Connect even if the network is not broadcasting.

7. Enter the Network name (printer name) and Security Key (password).

Note: To locate the Printer Name and Password, go to the Perfecta 2400STP, 

touch  at top left. The IP address and Password are listed 2nd from top.

8. At the Successfully added... prompt, click Close.
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3 Paper Handling

This chapter provides paper handling information about the VariQuest® Perfecta™ 
2400STP Poster Design System. The following information is contained in this chapter:

• “General Paper Loading Tips” on page 3-2
• “Loading Paper” on page 3-3
• “Paper Details” on page 3-13
• “Change Cutter Settings” on page 3-15
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General Paper Loading Tips
You can load paper into the printer in three ways: from a roll, as a single sheet, or 
as a stack of single sheets from the multi-sheet tray. Only one of these methods 
can be used at a time, and switching from one to another is a manual operation.

CAUTION!CAUTION!
Make sure the printer wheels are locked (the brake lever is pressed down) to 
prevent the printer from moving.

CAUTION!CAUTION!
All paper must be 280 mm (11 in) or wider. A4 and letter paper should not be 
loaded in landscape orientation.

When using photo paper, to avoid transferring oils onto the paper, wear cotton 
gloves.

CAUTION!CAUTION!
Keep the bin closed throughout the loading process.
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Loading Paper

Load Roll onto Spindle

Note: If you are a regular user of different paper types, you can change rolls more 
quickly if you preload rolls of different paper types on different spindles. Extra 
spindles are available for purchase, contact your authorized VariQuest Dealer or 
VariQuest Customer Service at 1.800.328.0585.

1. Open the roll cover.

2. Remove the spindle from the printer.

WARNING
Do not insert your fingers into the spindle supports during the removal 
process.

Note: The spindle has a stop at each end to keep the roll in position. The blue 
stop can be removed to mount a new roll; it slides along the spindle to hold rolls 
of different widths. 
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3. Remove the blue paper stop from the end of the spindle. If the roll is long, rest 
the spindle horizontally on a table and load the roll on the table.

4. Slide the new roll onto the spindle. Make sure the paper type is oriented as 
shown. If not, remove the roll, turn it 180 degrees and slide it back on to the 
spindle. Labels on the spindle show the correct orientation.
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Note: From the back of the printer, the blue stopper is inserted into the right-
side holder. Ensure both ends of the roll are as close to the spindle stops as 
possible.

5. Put the blue paper stop on to the open end of the spindle, and push it toward 
the end of the roll [1].

6. Ensure the blue paper stop is pushed in as far as it goes. Check that there is 
no space between the roll and the stops at both ends [2].

CAUTION!CAUTION!
The paper roll cannot exceed the blue hub. The printer only accepts rolls with 2-
inch cores. See Chapter 7 "Functional Specifications" for more information.

Note: If you regularly use different paper types, you can change rolls more quickly 
if you preload rolls of different paper types on different spindles. Extra spindles are 
available for purchase. Contact your authorized VariQuest® Dealer or the 
VariQuest Technical Support team for information.
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Load a roll into the Printer
To start this procedure, you must have a roll loaded on the spindle. See “Loading 
Paper” on page 3-3.

1. Swipe down on the dashboard and press , then touch Load Roll.

Note: Step 1 is optional: if you just start feeding in roll paper, the printer 
recognizes that you want to load a roll.

2. Open the roll cover.

3. Insert the spindle into the printer, holding it by both ends. The blue hub should 
be on the left, as viewed from the front of the printer.
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4. If the edge of the roll is not straight or is torn (sometimes due to the tape used 
to hold end of the roll), pull the paper slightly and cut a straight edge.

5. Insert the edge of the paper into the printer.

WARNING
Do not push your fingers inside the printer's paper path.

6. Roll the paper into the printer until you feel resistance and the paper flexes 
slightly. When the printer detects the paper, it beeps, and feeds in the paper 
automatically.
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7. The front panel prompts you to select the paper category and type. 

If you do not see your paper type in the front panel, touch More paper types. If you 
still cannot find your paper type in the whole list, see “Paper Type Missing from 
Printer Driver” on page 6-5.

8. The printer checks the alignment and measures the width. If the roll is not 
correctly aligned, follow the instructions on the front-panel display.

9. Close the roll cover. and touch OK.

Note: If you have an unexpected issue at any stage of the paper loading 
process, see “Paper Loading Error Messages” on page 6-4.
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Unload a Roll
1. To unload paper from the front panel: swipe down on the dashboard, then 

touch , then Unload a Roll.
2. Touch OK when ready.

Note: If the end of the paper is no longer attached to the core, the front panel 
prompts you to unload the roll manually. After unloading the paper, the multi-
sheet tray will become the default active paper source. 

3. Confirm the paper type and size loaded on the multi-sheet tray.

Load a Single Sheet

Note: Roll paper and single sheets use the same input slot in the printer.

Note: Sheet sizes of width 12.95 inches or less should be loaded from the multi-
sheet tray.

1. Swipe down on the dashboard and touch , then Load Single Sheet. If a 
roll is already loaded, you must wait until it is automatically unloaded.

2. If a roll is already loaded, touch Unload Roll and wait until it is automatically 
unloaded.

3. Open the roll cover.

Note: You do not need to unload the roll and spindle to load a single sheet.
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4. Insert the sheet into the right-hand side of the input slot.

WARNING
Do not push your fingers inside the printer's paper path.

5. Align the sheet with the blue line.

6. Feed the paper into the printer until you feel resistance and the paper bends 
slightly. When the printer detects the paper, it beeps, and feeds in the paper 
automatically.

7. On the front panel, touch OK to continue. 
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8. At the prompt, select the paper category and type. 

Note: If you do not see your paper type in the front panel, touch More paper 
types. If you still cannot find your paper type in the whole list, see “Paper Type 
Missing from Printer Driver” on page 6-5.

9. Guide the sheet into the printer; this is especially important with thicker 
papers. The printer checks the alignment and measures the sheet.

Note: Depending on the width of the sheet, it feeds out the front of the printer.

10. If the sheet is not correctly aligned, you may be prompted to reload it.

Note: If you have an unexpected problem at any stage of the paper loading 
process, see “Paper Loading Error Messages” on page 6-4.

Unload a Single Sheet

1. To unload a sheet, swipe down on the dashboard and touch .
2. Touch Unload Single Sheet.
3. As the sheet unloads out of the front of the printer; either catch it manually or 

allow it to fall into the bin.

Note: After unloading, the multi-sheet tray is the default active paper source.
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Use the Multi-Sheet Tray

Note: If no roll is loaded or the roll has run out of paper, the multi-sheet tray is 
active by default.

1. At the front panel, touch , then Use multi-sheet tray. If a roll or single 
sheet is already loaded, you must wait until it is automatically unloaded.

2. Adjust the input tray extensions depending on the length of the paper: the first 
extension for A4 and the second extension for A3 paper.

3. Adjust the output tray extensions depending on the length of the paper.

4. Load sheets of paper into the tray with the printed side facing outward. Ensure 
that the sheets are all of the same size.

5. Adjust the tray to fit the width of the paper.

[3]

[2]

[5]

[4]
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Paper Details

View Paper Information
To view the loaded paper information, press the icon of the active paper source. 
The following information is displayed on the front panel:

• Paper type you have selected
• Roll or sheet status
• Width of the paper in millimeters (estimated)

Note: If no roll or no single-sheet paper is loaded, or there is no paper in the multi 
sheet tray, the message Status: Not ready and Out of paper is displayed

Maintain Paper Quality
To maintain paper quality, follow these recommendations.

• Store rolls covered by another piece of paper or cloth.
• Store cut sheets covered and clean or brush them before loading them in the 

printer.
• Clean input and output platens.
• Always keep the top cover of your printer closed.

Note: Photo and coated paper requires careful handling, see “Troubleshooting 
Paper or Paper Quality Issues” on page 6-6.
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Change Drying Time
You may want to change the drying time setting to suit special printing conditions 
such as multiple prints where time is of higher importance or when you need to be 
sure ink is dry before handling. 

To change drying time:

1. Swipe down the dashboard, then touch .
2. Scroll down and touch Print retrieval > Select drying time. 
3. Choose from one of the options:

• Extended: Sets a longer than recommended time to ensure ink is completely 
dry.

• Optimized: Sets the default and recommended time for your selected paper 
(default setting).

• None: Disables the drying time and removes your print as soon as it finishes 
printing.

CAUTION!CAUTION!
CAUTION: If the ink is not dry when the print is removed it could leave ink in the 
output tray and marks on the print.

Note: If you cancel the drying time during a print, the printer may not feed and cut 
the paper immediately due to the printhead maintenance, which runs in parallel. If 
the dry time is zero, the printer cuts the paper and then performs the printhead 
maintenance. However, if the dry time is greater than zero, the printer does not cut 
the paper until after printhead maintenance has completed.
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Change Cutter Settings

Turn Automatic Cutter On and Off
To turn the printer's paper cutter on or off: 

1. Swipe down the dashboard and from the front panel, touch .
2. Touch Print retrieval > Enable cutter.
3. Change the cutter option. The default setting is On.

Note: If the cutter is turned off, it will not cut the paper between jobs, but it will 
continue to cut the paper on loading and unloading rolls.

To cut roll paper while the automatic cutter is disabled, see “Use Form Feed With 
or Without Cutting” on page 3-16.
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Use Form Feed With or Without Cutting
There are at least two reasons why you might want to advance the form feed with 
or without cutting:

• To trim the leading edge of the paper if it is damaged or not straight.
• To feed and cut the paper when the automatic cutter has been disabled.

To advance form feed:

1. Swipe down the dashboard and from the front panel, touch . Choose one 
of the following:

- Touch Form feed. The printer advances.
- Touch Form feed and cut. The printer advances the paper and makes a 

straight cut across the front edge. 

Note: The printhead is serviced after each print, and the paper cannot be cut 
until the process completes, so you may notice a delay.

CAUTION!CAUTION!
Remove the cut piece from the output platen. If strips or short prints are left on the 
output platen, the printer could jam. Check also that there are no pieces of paper 
in the cutter guide.

Note: Photo and coated paper requires careful handling, see “Troubleshooting 
Paper or Paper Quality Issues” on page 6-6.

2. To advance the paper without cutting it, swipe down on the dashboard, touch 

, then touch Form Feed.
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4 Printing

This chapter provides printing information about the VariQuest® Perfecta® 2400STP 
Poster Design System. The following information is contained in this chapter:

• “Print from USB” on page 4-2
• “Print from a Computer” on page 4-4
• “Advanced Print Settings” on page 4-4
• “Color Management” on page 4-11
• “Scanning” on page 4-13
• “Copying” on page 4-32
• “Mobile Printing” on page 4-35
• “Printing Examples” on page 4-37
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Print from USB
1. Swipe down the dashboard and touch the Print tab.

Note: If you haven’t connected your USB flash drive yet, a message will prompt 
you to do it.

2. Touch Print from USB. A list of the documents that can be printed will display.
You can sort them by touching:

- Name
- Date
- Size
- Type (JPEG, TIFF, HP-GL/2)

3. You can also search for the file by name. A keyboard will pop up; type the
name of the file and touch Find.

4. If an HP-GL/2 file is selected, the following screen will display:



VariQuest® Perfecta® 2400STP User’s Guide 4-3

Print from USB
Mobile printing

5. Touch the name of the file you want to print. 
6. Choose the settings:

- Number of copies (enter the name manually)
- Paper source (single sheet, multi-sheet, paper roll). 

7. Touch Print to start printing the document. 
8. To cancel the job in process, touch X. 
9. To print an image, touch the name of the image you want. 
10. To edit the image settings, touch the image as select the settings you want:

- Brightness
- Rotate image
- Select color settings. 

11. When done, touch Start Print.

Print settings
To change the print settings: 

1. Swipe down the dashboard and touch any of the following to modify the 
settings:

- Tray or paper
- Color
- Quality
- Resize
- Margin

2. Save the new settings as default by touching Save current settings.

Mobile printing
You print from your smartphone or tablet. See “Mobile printing” on page 4-3 for 
more information 
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Print from a Computer
Before you can print from a computer, the correct printer driver must be installed 
on the computer (see “Setting Up the Printer” on page 2-15), and the computer 
must be connected to the printer by network or WiFi.

When the printer driver has been installed and the computer connected to the 
printer, you can print from a software application by using the application's own 
Print command and selecting the correct printer.

Advanced Print Settings
This chapter explains the various print settings available for use on the printer. To 
satisfy all requirements., these methods offer a relatively large number of settings.

Normally, you should use the default settings unless you know they do not meet 
your requirements.
If you intend to reuse a specific group of settings repeatedly, you can save those 
settings under a name of your own choice and recall them later. A saved group of 
settings is known as a 'quick set' in the Windows printer driver.
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Select Print Quality
The printer has a variety of print-quality options because high-quality printing 
requires some loss of speed, while fast printing implies some reduction in print 
quality. Therefore, the standard print-quality selector is a slider that lets you 
choose between quality and speed. With some paper types, you can choose a 
compromise position between the two.

You can also select from the custom options: Best, Normal and Fast. If you 
select Fast, you can also select Economode. It uses a lower rendering resolution 
and consumes less ink, therefore increasing printing speed even further but 
reducing print quality. Economode can be selected only from the custom options 
(not from the slider).

There is also a supplementary custom option that may have an effect on print 
quality: Maximum Detail. See “Print High-Quality Output” on page 4-10.

Note: In the Windows driver dialog, the rendering resolution is displayed in the 
Custom Print Quality Options dialog box (select Custom Options>Settings).

To select print-quality options:

1. In the Windows driver dialog: select the Paper/Quality tab.
2. In the Print Quality section, select Standard Options to use the speed/quality 

slider. 
- or -

Select Custom Options to see the more specific options.

Note: You cannot change the print quality of pages that the printer is already 
receiving or has already received (even if they have not yet started to print).
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Select Paper Size
The paper size can be specified as follows:

Note: The specified paper size should be the paper size in which the document was 
created. It is possible to rescale the document to a different size for printing. See 
“Rescale a Print” on page 4-9.

To specify a paper size:

1. In the Windows driver dialog select the Paper/Quality tab.
2. In the Document Size list, select your paper size.

Note: If your application offers no Page Setup dialog, use the Print dialog.

Custom Paper Sizes
If you want to choose a paper size that is not included in the list of standard paper 
sizes, there are various different ways to specify it.

Use the Windows Printer Driver
A custom paper size created using the Windows printer driver has the following 
characteristics:

• The selected paper size is permanent and will not disappear if the driver is
closed or the computer is turned off.

• The paper size is local to the printer queue and will not be seen from other
printer queues in the same computer.

• In Domain server networks, the paper size is local to the computer. It will not
be seen from other computers sharing the printer queue.

• In Workgroup networks, the paper size will be shared among all the computers
sharing the printer queue.

• If the printer queue is deleted, the paper size is deleted with it.

To select paper size from Printer Driver:

1. Select the Paper/Quality tab.
2. Press the Custom button.
3. Enter the name and dimensions of your new paper size.
4. Press OK. The new paper size is automatically selected.
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Use Windows Forms
A custom paper size created in this way has the following characteristics:

• The selected paper size is permanent and will not disappear if the driver is 
closed or the computer is turned off.

• Restricted users cannot create paper forms. The “manage documents” role in 
the Windows Active Directory is the minimum required.

• The paper size is local to the computer. It will be seen in all the printer queues 
that have been created on the computer and that support paper of that size.

• If a printer queue is shared, this paper size will appear in all the client 
computers.

• If a printer queue is shared from another computer, this paper size will not 
appear on the driver’s document size list. A Windows form in a shared queue 
needs to be created in the server.

• If the printer queue is deleted, the paper size is not deleted.

To use Windows forms:

1. From the Start menu or Control Panel, select Devices and Printers, then 
Select Printer.

2. In the Forms tab, check the Create a new form box.
3. Enter the name and dimensions of your new paper size. Leave the margins 

as 0.00.
4. Press Save Form.
5. Go to the printer driver, and select the Paper/Quality tab.
6. From the drop-down list of paper sizes, select More… .
7. Select your new paper size from the group of Custom sizes.
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Choose Margins Options
By default, the printer leaves a 5 mm margin between the edges of your image 
and the edges of the paper, increased to 17 mm at the foot of cut-sheet paper. 
However, you can change these settings.

To change margins options:

1. In the Windows driver dialog, select the Paper/Quality tab.
2. Click the Margins/Layout button.
3. Choose from the following options.:

• Standard. The image will be printed on the selected paper size, with the 
default margin between the edges of the image and the edges of the paper. The 
image should be small enough to fit between the margins.

• Oversize. You should load paper that is larger than the size you selected in 
the application or driver. If you cut off the margins after printing, you will be left 
with a page of the size you selected, with no margins remaining between your 
image and the edges of the paper. This is useful when you want your image to 
cover the whole area of the paper.

• Clip Contents By Margins. The image will be printed on the selected paper 
size, with the default margin between the edges of the image and the edges of 
the paper. In this case, if the image is the same size as the page, the printer 
assumes that the extreme edges of the image are either white or unimportant, 
and do not need to be printed. This may be useful when your image already 
contains a border.

Print on Loaded Paper
To print a job on whichever paper is loaded in the printer:

• In the printer driver Paper Type option, select Use printer settings/Any.
• In the Windows driver dialog, select Paper/Quality tab, then in the Paper Type 

drop-down list, select User printer settings.
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Rescale a Print
You can send an image of a certain size to the printer but tell the printer to rescale 
it to a different size (normally larger). This may be useful:

• If your software does not support large formats
• If your file is too large for the printer's memory—in this case, you can reduce 

the paper size in your software and then scale it up again using the front-panel 
option 

To rescale an image:

1. From the Windows driver dialog, select Layout/Options tab.
2. In the Resizing Options section, choose from the following:

• Print document on option: Adjusts the image size to the paper size you 
selected. For example, if you selected ISO A2 as the paper size and you print 
an A3-sized image, it is enlarged to fit the A2 paper. If the ISO A4 paper size 
is selected, the printer reduces a larger image to fit the A4 size.

• % of actual size option: Enlarges the printable area of the original paper size 
(page minus margins) by the percentage indicated, then adds the margins to 
create the output paper size.

Note: If you are printing to a single sheet, you must ensure that the image can 
actually fit onto the sheet, otherwise the image will be clipped.

Print Draft-Quality Output

Note: You can specify faster draft-quality printing by using Economode. This is 
intended mainly for documents containing only text and line drawings.

To specify fast draft-quality printing:

1. In the Windows driver dialog: select Paper/Quality tab.
2. In the Print Quality section, move the print-quality slider to the extreme left 

('Speed').

To specify Economode draft-quality printing:

Note: Economode is even faster draft-quality printing and is intended mainly 
for documents containing only text and line drawings.

1. In the Windows driver dialog, select Paper/Quality tab.
2. In the Print Quality section, select Custom Options.
3. Set the quality level to Fast and check the Economode box.
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Print High-Quality Output
To specify high-quality printing:

1. In the Windows driver dialog, select Paper/Quality tab.
2. In the Print Quality section, move the print-quality slider to the extreme right

('Quality').

Print High-Resolution Images
To print an image with a resolution greater than the rendering resolution:

Note: This option is available only if you are printing on glossy paper and have 
selected Best print quality.

1. Select Custom Print Quality Options and check the image resolution.
2. To improve print sharpness, select Maximum Detail option.

Note: The Maximum Detail option results in slower printing with photo papers, 
but it does not increase the amount of ink used.

Paper Economy
To save roll paper:

1. In the Windows driver dialog, select Layout/Output tab.
2. Select one or more of the these options:

• Remove blank areas
• Rotate by 90 degrees
• Autorotate.

Ink Economy
Use the following recommendations for making economical use of ink.

• Draft prints: Use plain paper and move the print-quality slider to the left end
of the scale ('Speed'). For further economy, select custom print quality options,
then select Fast and Economode.

• Clean Printhead only when Needed: Cleaning the printhead can be useful,
but it uses a small amount of ink.

• Leave Printer Power ON: When the printer is permanently turned on, it can
maintain the printhead in good condition automatically. This regular printhead
maintenance uses a small amount of ink. However, if it is not done, the printer
may need to use much more ink later to restore the health of the printhead.

• Print using Wide Prints: Wide prints make more efficient use of ink than
narrow prints, because printhead maintenance uses some ink, and its
frequency is related to the number of passes made by the printhead.
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Color Management
Your printer has been engineered with advanced hardware and software features 
to ensure predictable and dependable color results.

• State-of-the-art printheads and inks
• Dedicated color resources for most available paper types
• Color emulation

Color Management Options
The aim of color management is to reproduce colors as accurately as possible on 
all devices: so that, when you print an image, you see very similar colors as when 
you view the same image on your monitor. Color management is highly 
dependent on the paper type loaded at the printer, so be sure to select the correct 
preset for the paper type you are using.

The color management options for your printer can be selected from the Color 
menu in the Windows driver dialog. In some applications you can make the choice 
in the application itself. 

• Application-Managed Colors: Your application program must convert the
colors of your image to the color space of your printer and paper type, using
the ICC profile embedded in the image and the ICC profile of your printer and
paper type.

• Printer-Managed Colors: Your application program sends your image to the
printer without any color conversion, and the printer converts the colors to its
own color space. The color management in the printer is done using a set of
stored color tables. ICC profiles are not used. This method can produce very
good results with supported paper types. There are two color spaces that the
printer can convert to its own color space using the stored color tables: sRGB
and Adobe RGB.
- sRGB emulates the characteristics of the average computer monitor. This

standard space is endorsed by many hardware and software
manufacturers, and has become the default color space for many
scanners, cameras, printers, and software applications.

- Adobe RGB provides a larger color gamut than sRGB. Use this space if
you need to do print production work with a wide range of colors.
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Printer Emulation
If you want to print a job and see approximately the same colors that you would 
get from printing the same job on a different Designjet printer, you can use the 
emulation mode provided by your printer.

Note: Printer emulation is available only when printing an HP-GL/2 job on plain or 
coated paper.

To use printer emulation:

1. In the Windows HP-GL/2 driver dialog, select Color tab.
2. Select Printer Managed Colors.
3. From the Source Profile list, select Printer Emulation.
4. Select from the Emulated Printer list.

Printing Greyscale or Black-and-White
You can convert all colors in your image to shades of grey as follows:

• Application Program: Many applications provide this option.
• Windows Driver Dialog: From the Color tab, choose Color Options.
• Select Print in Greyscale. Only the black ink will be used for printing, except 

if the paper loaded is glossy, in which case colored inks are used to compose 
the gray shades. You can also select Print in pure black and white if you 
want only black and white output with no gray shades. In this case, only black 
ink will be used for printing. 

Note: The Print in pure black and white option is not supported when 
printing on glossy paper.
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Scanning

Suitable Paper Types
The scanner may not support the full range of paper types that may be used by 
the printer. The following paper categories are supported by the scanner.

• White paper: Any matte original printed with inkjet technology (e.g., anything
printed on Universal Inkjet Bond Paper, Coated Paper, Heavyweight Coated Paper,
plain paper).

• Photo paper: Glossy and satin originals. Inkjet, offset, and traditional photo
technologies are supported (e.g., any photo or other image printed on Universal
High Gloss Photo Paper or Premium Instant Dry Gloss/Satin Photo Paper).

Note: For some specific photo originals, completely accurate results may not 
be achieved.

CAUTION!CAUTION!
Photo and glossy papers may be scratched while passing through the scanner.

• Translucent paper: Semi-transparent tracing papers (> 65 g/m²), including Natural
Tracing Paper, Vellum, and Translucent Bond.

• Blueprints: For scanning blueprint originals with optimum results, in grayscale
only. This option greatly enhances the contrast of the resulting image.

• Unsupported Paper Types: This scanner does not support the following paper
types:
• Film
• Backlit material
• Cling material
• Translucent paper (< 65 g/m²)

CAUTION!CAUTION!
Do not use documents with staples or rough surfaces/materials than can damage 
the scanner glass

The following image is a QR code containing a link to a video to get more 
information about how to scan. 
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Scan to File
You can scan to the following destinations:

• Computer
• Network folder
• Email
• USB

You can start a scanning process in two ways:

1. On the front panel, touch Scan tab.

2. Select where you want to store the scanned image.
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3. Feed the document directly:
• Load the sheet with the printed side facing up (you can also load the sheet

before step 1, if you prefer).
• Align the center of the sheet approximately with the center of the scanner. Use

the standard size markings to help you.

Note: The maximum allowed paper length depends on the paper width and 
scan resolution. An alert is displayed if the maximum memory is exceeded.

4. Push the sheet into the insertion slot until you feel it contact the rollers. The
scanner will automatically grab the sheet and move it into position for
scanning. If you feel that the sheet has loaded badly and you want to try
again, you can pull it out manually.

Important
Do not try to feed the scanner while the printer is printing. Only one action can be 
done at a time. Paper will not be accepted by the scanner during printing.

5. At the front panel, go to the home screen and touch the Scan tab, then select
where you would like to store the scanned image:
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Scan to Email
Before scanning, make sure you have followed the Scan to email setup process. 
The scan-to-email setup must be done from the Embedded Web Server. For 
more information, go to “Scan to Email” on page 4-16.

If the setup process has not been done, the following message displays:

1. Touch Next.
2. Enter the email address(es) to which the scanned job will be sent. The Scan-

to-email user interface options are:
• Sender
• Send to:
• Contact
• Group
• Addresses 

3. Swipe down the dashboard and touch  to change the Scan-to-Email 
settings. For further information, go to “Scan to Email” on page 4-16.

4. To continue:

• Touch  to eject the already fed document.
• Touch Start Scan to start the scanning process.

Note: If a scanned image is larger than the maximum size permitted, the printer 
will ask if you want to try to send it anyway. To change this option, go to the 
Embedded Web Server and select Scan to email setup > Maximum size of 
email.
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Scan to a Network Folder
Before starting the process, make sure you have followed the Scan to Network 
folder setup process. The scan to Network folder setup must be done from the 
Embedded Web Server. For more information, go to Scan to Network folder 
setup process on “Scan to Network Setup Process” on page 4-24.

Note: You can also use the Printer Utility to access the Scan to network option.

To scan to a network folder: 

1. Choose a folder accessible through the network.
2. To create and/or change the folder options, go to the Embedded Web Server, 

and follow the instructions of the Network folder setup process.

3. Enter the security PIN (if prompted).

Note: A security PIN can be associated with each folder; check Network folder 
setup on “Scan to Network Setup Process” on page 4-24. 

4. Touch Done.
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5. In the Scan to screen, enter the folder(s) to which the scanned job will be sent. 
The Scan-to-Network folder options are:
• Save As
• File Name
• Resolution

6. Swipe down the dashboard and touch  to change the network folder 
settings. For further information on settings go to “Scan to Network Setup 
Process” on page 4-24.

7. To continue:

• Touch  to eject the already fed document.
• Touch Start Scan to start the scanning process.
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Scan to Computer
There are two ways of scanning to a computer:

• Webscan: You can scan to computer from the Embedded Web Server. Look for 
the Scan to computer option, then select Webscan. There are fewer scan 
settings available for scanning to a computer.

Note: This option must be enabled on the Embedded Web Server to be able 
to Webscan. For more information go to Scan to computer setup > Webscan. 
See “Webscan” on page 4-29.

- Touch Start Scan to start the process. Your default browser will open on 
your computer with a PDF viewer showing the scanned image. 

- Save the image to your computer.

Note: 

• WSD (from server and from printer).

Note: This option must be configured on your computer before you can Scan to 
computer from server/from printer. For more information on Scan to computer 
from server/ from printer setup see “From Server/From Printer” on page 4-30.
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Scan to USB
When scanning to USB, a folder named HPSCANS is created on the USB drive 
and the file is saved in that folder. The file format is saved as PDF, JPEG, or TIFF 
using an automatically generated file name if you have not given it one.

Scan to USB user interface options:

• Save As (format file
• File name
• Resolution

To scan to USB:

1. Swipe down the dashboard and touch  to change Scan-to-USB settings. 
For further information on settings go to “Scan Settings Available” on page 4-
21.

2. Touch  to eject the already fed document.
3. Touch Start Scan to start the scanning process.

Scanning from a Mobile Device
You can also scan from your smartphone or tablet: See “Mobile printing” on 
page 4-3.
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Scan Settings Available

Note: Some of the default scan settings are displayed in the list below. 

To change scan settings:

1. Touch Settings to see the complete list of settings.
2. Check that the Original type setting corresponds to the paper type you intend 

to scan.
3. Change scan settings as desired.
4. When done, touch Save current settings, then touch Back to return to 

where you were.

Original
• Lighter/Darker: Allows you to modify the lightness of the scan using a slider.
• Background noise removal: Clears the noise on the original background.
• Background color removal: Cleans the color in the original background.
• Blueprint: Used for scanning blueprint originals with optimum results. This option 

converts to greyscale and inverts the colors, if needed, producing a white 
background with black lines.

• Translucent Media: A mode specifically for scanning NTP/vellum/other 
translucent media.

Scan Settings
• Resolutions: Lets you specify the scan resolution (200, 300, 600 dpi)
• Color options: Lets you choose color, greyscale, or black and white scanning.
• Auto De-skew: Corrects the skew automatically (default is On).
• Scan full width (36”): Does not crop the scan to the original edges (default is Off).

Save Settings
• Save as: Format Lets you specify the format of the file in which the scanned image 

will be saved: TIFF, JPEG, or PDF.
• File Name
• File compression: allows you to specify the level of compression: High (the 

default level), Medium, or Low. This option is available if the format is JPEG or PDF.

Defaults
• Save current settings
• Restore to factory defaults
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Scan Options Setup Process
A scanned image may be saved in a USB flash drive, in a network folder, or in an 
email. The USB flash drive option requires no preparation, but the other options 
will not work until they have been set up in the following way.

To set up scan options:

1. Go to the Embedded Web Server in your computer. 
2. Access the Embedded Web Server by typing the printer’s IP address into 

your browser. 
3. Find your printer’s IP address on the dashboard Home screen.
4. Once in the Embedded Web Server, look for the option you want to set up.
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Scan to Email Setup Process
1. To set up Scan to email, follow the process in the Embedded Web Server. 
2. Enter or change the available options (see list below).

Outgoing Email Settings:

• To: Select the default address destination
• From: Define the default email address for the sender
• Default from: Specify the default email name
• Default display name: Specify the default name for the email sender

SMTP Server: the IP address of the outgoing mail server (SMTP) that will process 
all email messages from the printer. If the mail server requires authentication, 
email notifications will not work.

SMTP Port: Set the default SMTP port number of your outgoing email server

Maximum size of email: Defined by your email server

Server Authentication: Depends on your email server settings
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Scan to Network Setup Process
A scanned image may be saved in a network folder. The USB flash drive option 
requires no preparation, but the other options will not work until they have been set 
up in the following way. 

To set up the Scan to network folder, you must first create a folder on your 
computer.

To create a scan to network folder:

1. Create a folder on a computer that the scanner can access through the 
network. 

2. Create a user account on the same computer for the printer.
3. Change the sharing options of the folder so that it is shared with the scanner 

user, and assign full control of the folder to that user. 
4. Create a share name for the folder.

5. Once the shared folder is created, go to the Embedded Web Server and 
follow the instructions under the Scan to network folder setup process.
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6. In the printer's Embedded Web Server, select the Scan tab and then Scan to 
network folder. See “Access the Embedded Web Server” on page 2-18.

7. Select an existing profile or to create a new network folder profile.
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8. Write a name for the folder and type the network path. 
• Display Name: Displayed in the front panel when you are choosing the scan 

destination. It may be different from the network or FTP folder name.
• Network Path: Include the network name of the remote computer.
• Server and Folder names: Used to connect to the shared folder by building 

a network folder path as follows: \\server name\folder name
• Network Path: The name or IP address of the remote computer and the name 

of the shared folder.

9. Select Next to continue.
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10. Define Log-in Authentication settings:
• User name: Contains the name of the 'scanner user'.
• Password: Contains the password of the 'scanner user'.

11. Enter user name and password of the 'scanner user' that you have already 
created on the remote computer. 

Note: Leave user domain field empty unless user is a member of a Windows 
domain. If user is only a local user of the remote computer, leave field empty. 
You can use the name (instead of IP address) in server name field only if the 
shared folder is on a Windows computer in the same local network. The name 
must be simple (up to 16 characters long) without a domain suffix (no dots in 
the name). Fully qualified DNS domain names are not supported. If the product 
and network folder are in different networks, or if the remote computer is not 
running Windows, then you must use the IPv4 address instead of the name of 
the remote computer. On IPv6 networks, IPv6 address is also supported.

12. Select Next to continue.
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13. Define the Setup Configuration for files scanned to the network folder.

Note: The scan settings defined for a folder, are exclusive for the setup folder.

1. Define the scan settings fields for files scanned to the network folder.
• Original size lets you resize the print: to a percentage of its original size, or to

fit a particular paper size (default is 100% of its original size).
• Darkness

2. Define the file settings fields for files scanned to the network folder.
• Default file name
• Default file type
• Default color preference
• Default output quality
• Default resolution
• Black TIFF compression
• Color/Grayscaale TIFF compression

3. Click Save only to save the configuration or click Save and Test to save the
configuration and perform a test to check the network folder is correctly set up.

Note: You can check any time that the shared folder remains accessible by 
clicking Test in the Embedded Web Server. A correctly configured shared 
folder can become inaccessible if the user’s password is changed or if the 
shared folder is moved or deleted.

4. Click Add to save the configuration.

Note: If the printer has already been configured for scanning to the network 
and you want to use a different shared folder, click Edit.
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Scan to computer
There are two ways to scan to a computer:

• webscan
• from server/from printer 

Webscan
To use Webscan, the option has to be enabled in the Embedded Web Server. 
Under the Settings tab, look for Webscan from EWS and make sure it is 
enabled.

To enable Webscan:

1. Under the Settings tab, select Security > Administrator settings.
2. Under Printer features, choose an option:

• Enable all.
• Printer settings > Webscan from EWS.

3. Select Apply.
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From Server/From Printer
To scan from server/from printer, you have to follow Windows setup process 
defined for adding a device.

1. Locate Devices and printers > Add a device and follow the instructions.

Example: Create a scan-to-network folder under Windows
1. Create a new user account for the 'scanner user' on the remote computer. You 

can use an existing user account for this purpose, but it is not recommended.
2. Create a new folder on the remote computer, unless you want to use an 

existing folder.
3. Right-click the folder and select Properties. 
4. In the Sharing tab, click Advanced Sharing.
5. Check the Share this folder box.

Note: You must verify that the 'scanner user' has full read/write control over the 
shared folder.
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6. Click Permissions and grant Full Control to the user (or to any group that 
includes that user). 

7. If there is a Security tab in the Properties window for the folder, you must also 
grant the same user Full Control over the folder in the Security tab. Only 
some file systems such as NTFS require this.
The scanner user can now access the folder and write files to it. You must 
next configure the printer to send scans to the folder.

Mobile scanning
You can also scan from your smartphone or tablet. See “Mobile printing” on 
page 4-3 for more information. 
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Copying
When performing the copy process, the printer first scans the original into its 
memory and then prints the scanned image.

Note: The maximum paper length allowed depends on the paper width and scan 
resolution. An alert is displayed if the maximum memory is exceeded.

CAUTION!CAUTION!
Do not try to feed the scanner while the printer is printing. Only one action can be 
done at a time. Paper will not be accepted by the scanner during printing

1. On the front panel, touch the Copy tab.

2. Touch the suitable option for your document:
• Lines
• Image
• Mixed (both images and lines, such as a map)

3. Select the number of copies that you want . You can choose a number ranging 
from 1 to 99. You can enter the number manually or select it from a slider.

4. Select the paper source you are going to copy to:
• Roll
• Multi-sheet tray
• Single sheet

5. Select the copy quality option: Best, Normal, Draft. 
6. Touch Copy. You will be prompted to load the original document if you haven’t 

already.
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7. Push the sheet into the insertion slot until you feel it contact the rollers. The 
scanner will automatically grab the sheet and move it into position for 
scanning. 

8. If the sheet has loaded badly, you can pull it out manually and retry.
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Copy Settings

1. Touch  Settings to see the complete list of settings. 
2. When satisfied with the scan settings, touch Save current settings, then touch 

Back to return to the previous screen. 

Some of the default copy settings are: 

Original Settings
• Content type
• Lighter/darker: Adjust lightness of the copy.
• Background noise removal: Reduces image defects such as wrinkles.
• Background color removal: Reduces color defects in the original 

background.
• Blueprint: Copy blueprint originals with optimum results. This option converts 

images to greyscale and inverts the colors, if needed, producing a white 
background with black lines.

• Translucent Media: Used specifically for copying images that are on 
NTP/vellum/other translucent media (as opposed to opaque media) to obtain 
optimum results. 

Scanning
• Color options: Specify the colors for your copy (color, greyscale, black and 

white).
• Auto De-Skew: Automatically corrects skew (default is On).
• Scan full width 36in: Ensures the copy is not cropped to the edge of original 

image (default is Off). 

Printing Settings
• Resize: Lets you resize the print to a percentage of the original size, or to fit 

the copy to a particular paper size (default is 100% of the original size).
• Paper Source: Choose between Roll, Multi-sheet Tray or Single Sheet when 

printing.
• Copy Margins: Lets you decide how to manage printer margins. You can print 

the scanned image as is and add margins or you can clip the image with the 
printing margins (Add to Contents, Clip to Contents).

• Quality: Defines copy resolution and print quality.

Defaults
• Save current settings
• Restore to factory defaults
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Mobile Printing
You can print to your printer from many mobile devices and from almost any 
location. There are two main methods of Mobile Printing:

• Direct printing by connection to the same network
• Printing by email

Your printer can be connected to the Web, providing various benefits:

• Automatic firmware updates (see “Automatic Firmware Update” on page 2-
15)

• Print from almost anywhere
• Print from almost any device, including smartphones, tablets, and laptops

See http://www.hp.com/go/designjeteprinters for more detailed information.

You can enable Web Services when setting up the printer: see “Setup Web 
Services” on page 2-17 or the Assembly Instructions for more information.

Important
The printer must be connected to a network: connect an Ethernet cable for a wired 
connection, or start the Wireless Wizard in the Connectivity menu for a wireless 
connection. See Connecting the printer on page 15.

Print from Mobile Device

iPhone, iPad
Printing with AirPrint™ is simple, all you have to do is make sure your device and 
printer are operating on the same network and follow the steps below.

1. Choose your content: open the document or photo you want to print, then 
tap the share button.

2. Select print icon: Swipe screen to reveal print button on bottom, then tap the 
print icon.

3. Print: Confirm the correct printer and print setting are selected, then tap Print 
and collect your documents.

All Androids
Printing with Android devices is simple and depending on your model, printing 
may already be preloaded on your device. If it is not, download the HP Print 
Service Plugin from the Google play store to get started.

1. Choose your content: Open the document or photo you want to print, tap the 
menu icon and select Print.

2. Choose your printer: Select from the list of printers that appears.
3. Print: Confirm the correct printer and print setting are selected, then tap Print 

and collect your documents.
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Print by Email (HP ePrint)
If you can email it, you can print it. Simply attach a PDF or other print-ready file to 
an email message and send it to your printer’s dedicated address.

In this way, you can print from anywhere with an Internet connection, without 
needing any printer driver. There are a few limitations that you should bear in 
mind: 

• Files must be in PDF, JPEG, or TIFF formats.
• Maximum file size is 10 MB, but your email server may have a lower limit.
• Files are printed in the original document size (at 100% scale), in normal 

quality, in color, and normally in portrait orientation (some printers may offer 
autorotation).

Print, Scan, and Share from All-in-One (AIO) Remote App
Use the screen on your mobile device to control printer scan and print functions. 
Send scans directly to your mobile device from your printer. Print PDF, photos, 
email attachments, and more from virtually anywhere.

Note: Mobile devices must have an Internet connection and email capability.

Scan and copy control requires that the mobile device and printer be on the same 
wireless network or have a wireless-direct connection to the printer.

Apple/Android Printing 
1. Choose your content: Open the document or photo you want to print, tap the 

share icon and select AiO.
2. Open in All-in-One Remote: Go to settings to adjust Quality or Color Mode if 

necessary.
3. Print: Confirm the correct printer and print setting are selected, then tap Print 

and collect your documents.

Apple/Android Scanning and Sharing 
1. Load document to be scanned: Place document on the printer.
2. Open in All-in-One Remote: Trigger scanning from the app. You can store 

the document in your mobile device.
3. Share: Select sharing through email or your preferred repository.

Mobile Specifications
• Mobile devices must have an Internet connection and email capability.
• Scan and copy control requires that the mobile device and printer be on the same 

wireless network or have a wireless-direct connection to the printer.
• Printing requires an Internet connection to an HP printer.
• iOS 7.0 and above, or Android KitKat4.4 and above, is required. 
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Printing Examples
Use the examples in this section as a general guide to help you print from other 
applications.

Adobe Acrobat
To print from Adobe Acrobat:

1. In the Acrobat window, move the mouse cursor to the bottom left corner of the 
document pane until the document size appears there.

2. Select File > Print.
3. Set Page Scaling to None.

Note: The page size will not be automatically selected according to the 
document size.
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4. Press Properties, then select the Paper/Quality tab.

5. Choose the Document Size and Print Quality you want to use. 
- or -

To define a new custom paper size, press Custom.
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6. Select the Features tab, then check the box for Autorotate.

7. Click OK.
8. In the Print dialog, check that the print preview seems correct., then click OK.
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Print from Autodesk AutoCAD
The AutoCAD window can show a model or layout. Normally a layout is printed 
rather than the model.

To print from AutoCAD:

1. At the top of the CAD window, click the Plot icon. The Plot window opens.
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2. To view more options, press the circular button in the lower right corner of the 
window.

Note: The Quality option does not refer to the final print quality but to the 
quality of AutoCAD viewport objects that are sent for printing.

3. Press Properties, then select the Device and Document Settings tab.
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4. Press Custom Properties.

5. In the Paper/Quality tab, select the paper type that you intend to use.

6. Select the print quality (your choice between speed and quality of printing).

Note: If you intend to print on roll paper, you must choose where the printer 
should cut the paper. 
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7. Press Margins/Layout button and select Clip contents by margins.

8. Select the Features tab, then click the box for Autorotate (Autorotation can 
help to avoid wasting paper).

9. Press OK and save your configuration changes to a PC3 file.
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Using Printer Emulation
To request printer emulation:

1. Select Color>Color Management>Printer Managed Colors >Printer 
Emulation.

2. Select Off (no printer emulation) or the name of the printer model that you 
want to emulate. 

Note: This setting applies only to jobs that do not contain any printer emulation 
setting saved in the job.

Using Clip Contents by Margins
Use this option when the contents to be printed have white borders and a size 
equal to that of the paper you have selected. The printer will use the white border 
for its margins and you will get a page of size equal to that which is selected in the 
driver.

To setup clip contents by margins:

1. Select Paper/Quality>Margins/Layout>Print with Margins>Layout>Clip 
Contents by Margins.
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Print from Adobe Photoshop
1. In Photoshop CS5, select File > Print and then select your printer.

2. Choose from the available paper sizes.
- or -

If you do not find the paper size that you want, press Custom. 
- Enter the width, the length and the name of your custom paper size. 
- Press Save, then OK.

3. If desired, change the default Paper Source, Paper Type and Print Quality.
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4. Select the Color tab.
5. Verify that the default color management option Printer managed colors is 

selected. 

Note: This is the correct option because you already selected Printer Manages 
Colors in Photoshop.
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Print and Scale from Microsoft Office
This section demonstrates how to print and scale from the applications in 
Microsoft Office 2013.

PowerPoint
1. Select File>Print, and select the name of your printer.

2. Select Printer Properties > Layout/Output > Fit to to scale the document to 
a specific size.
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3. Select the Paper/Quality tab, then choose your Paper Source and 
Paper Type.

4. Select Margins/Layout, then select Clip contents by margins to keep the 
size.
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Project
1. Select File>Print.

2. Select Page Setup and choose the Paper Size from the drop-down list.

3. Select Options to go to the printer driver.
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4. Select the Paper/Quality tab and verify the settings:
• Paper source: User Printer settings
• Paper Type: Use Printer Settings

5. Select Layout > Fit to to scale the document to a specific size. 

Note: You can also scale the document in Project.
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Excel
1. Select the Page Layout tab. 
2. Select Size, and choose the paper size you want.

3. Select the File tab.
4. Select Print, and select the name of your printer.
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5. Select Printer Properties to go to the printer driver. 
6. In the Paper/Quality tab, select Paper source, Paper type and Print Quality.

7. Select Layout/Output > Fit to to scale the document to a specific size. 

Note: You can also scale the document in Excel.
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5 Ink Cartridge Handling

This chapter provides information about maintenance for the VariQuest® Perfecta® 

2400STP Poster Design System. The following information is contained in this chapter:

• “Ink Cartridge Maintenance” on page 5-2
• “Printer Maintenance” on page 5-5
• “Software and Firmware Updates” on page 5-14
• “Printer Maintenance Kits” on page 5-15
• “Scanner Maintenance” on page 5-16
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Ink Cartridge Maintenance
Ink cartridges store the ink and are connected to the printhead, which distributes 
the ink on the paper. To purchase additional cartridges, see Accessories.

CAUTION!CAUTION!
Observe precautions when handling ink cartridges because they are ESD-
sensitive devices (see the Glossary on page 143). Avoid touching pins, leads and 
circuitry.

Note: This printer is not designed to use continuous ink systems. To resume 
printing, remove continuous ink system and install genuine (or compatible) 
cartridges.

Note: This printer is designed for ink cartridges to be used until they are empty. 
Refilling cartridges prior to depletion might cause your printer to fail. If this happens, 
insert a new cartridge (either genuine or compatible) to continue printing.

Storing Anonymous Usage Information
Each ink cartridge contains a memory chip that assists in printer operation. The 
memory chip also stores a limited set of anonymous information about the usage 
of the printer, which can include the following: date first installed, last used date, 
number of pages printed, page coverage, frequency of printing, printing modes 
used, any printing errors that may have occurred and the product model.

This information helps us design future products to meet our customers' printing 
needs. The data collected by the memory chip does not include information that 
could be used to identify a customer or user of the cartridge or printer.

The sampled memory chips are read and studied to improve future products. 
Partners who assist in recycling ink cartridges may also have access to the data. 
Any third party possessing the cartridge may be able to access the anonymous 
information on the memory chip. If you prefer to not allow access to this 
information, you can render the chip inoperable. However, after you render the 
memory chip inoperable, the cartridge cannot be used in an HP printer.

If you are concerned about providing this anonymous information, you can turn off 
the memory chip's ability to collect printer usage information. To do so, access the 
Embedded Web Server, and select Settings > Anonymous Usage Information 
Storage. This does not prevent the cartridge from working normally in other 
respects. However, if you change your mind later, you can restore the factory 
defaults to resume collecting printer usage information.
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Ink Cartridge Status
To view the ink levels of your ink cartridges:

1. Swipe down on the dashboard of the front panel and press .
2. Touch the desired ink level for more information.

Replace Ink Cartridge
There are two occasions when you need to replace an ink cartridge.

• Ink cartridge is very low. You should replace it with a full cartridge for 
unattended printing (you can use the remaining ink in the first cartridge at a 
more convenient time).

• Ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION!CAUTION!
Do not try to remove an ink cartridge while printing. Remove an ink cartridge only 
if you are ready to insert another one.

Note: When a cartridge runs out of ink, the current job is cancelled.

To replace an ink cartridge:

1. Turn the printer ON.
2. If your printer is on a stand, make sure the printer wheels are locked (the 

brake lever is pressed down) to prevent the printer from moving.
3. Open the ink cartridge cover on the left-hand side of the printer.
4. Wait until the carriage stops moving, then press the ink cartridge to unlock it.
5. Remove the ink cartridge.

6. Insert the new ink cartridge. Make sure that you insert the ink cartridge into 
the slot that has the same colored letter as the cartridge you are installing.

7. Close the ink cartridge cover.

[5][3]

[7][6]
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About the Printhead
The printhead comes installed in the printer and is connected to the ink cartridges. 
The printhead jets ink onto the paper.

CAUTION!CAUTION!
Observe precautions when handling the printhead, because it is an ESD-sensitive 
device (see “Glossary” on page A-2). Avoid touching pins, leads, and circuitry.
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Printer Maintenance
The printer is not designed for any purpose other than printing, copying and 
scanning. Do not use the printer as a table. The surface can easily be damaged. 
and if anything falls into the printer, it can cause serious damage.

Checking Printer Status
You can check the current status of the printer in various ways:

• From the HP Utility, select your printer to see a page of information describing 
the status of the printer and its paper and ink supplies.

• From the Embedded Web Server, you can see information about the general 
status of the printer. The Supplies page in the Main tab describes the status of 
the paper and ink supplies.

• From the front panel, you can get information about the loaded paper and the 
ink levels.

Cleaning Printer Exterior
Clean the outside of the printer and all other parts of the printer that you regularly 
touch as part of normal operation with a damp sponge or a soft cloth and a mild 
household cleaner such as non-abrasive liquid soap.

WARNING
To avoid an electric shock, make sure that the printer is turned off and 
unplugged before you clean it. Do not let water get inside the printer.

CAUTION!CAUTION!
Do not use abrasive cleaners on the printer.
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Print Quality Diagnostic Report
The Print Quality Diagnostic Report consists of two test patterns designed to 
highlight printhead reliability problems. It helps you check the performance of the 
printhead that is currently installed in your printer, and determine if it suffers from 
clogging or alignment problems.

To print the Print Quality Diagnostic Report:

1. Use the same paper type used when you detected a problem. The test 
patterns are easiest to evaluate on plain white paper.

2. Check that the selected paper type is the same as the paper type loaded into 
the printer. See “View Paper Information” on page 3-13.

3. Swipe down the front panel and press .
4. Scroll down the menu and touch Image Quality Maintenance > Print 

Diagnostic Image.

Note: The report can also be requested from the Embedded Web Server. It 
takes about two minutes to print the report.
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Corrective Actions
1. If the lines in Test Pattern 1 are not straight and connected, align the 

printhead (see “Aligning the Printhead” on page 5-8).
2. If any of the colored blocks in Test Pattern 2 show white lines, are faded or 

completely missing, clean the printhead (see “Cleaning the Printhead” on 
page 5-7). Follow the front-panel prompts and perform all three levels of 
cleaning if necessary.

3. If the problem persists, clean the printhead again.
4. If the problem remains, replace the ink cartridge (see “Replace Ink Cartridge” 

on page 5-3) corresponding to the streaked, faded, or missing color block in 
Test Pattern 2.

5. If the problem continues to persist, replace the printhead (see “Replacing the 
Printhead” on page 5-9). If the printhead is still in warranty, contact your 
Varitronics Dealer for support.

Cleaning the Printhead
If your print is streaked or has incorrect or missing colors, the printhead may need 
to be cleaned. There are three stages of cleaning. Each stage lasts about two 
minutes, uses one sheet of paper, and an increasing amount of ink. After each 
stage, review the quality of the printed page. You should initiate the next phase of 
cleaning only if the print quality is poor.

If print quality still seems poor after completing all stages of cleaning, try aligning 
the printhead.

Note: Cleaning uses ink, so clean the printhead only when necessary.

CAUTION!CAUTION!
Failing to turn off the printer correctly can cause print-quality problems.

To clean the printhead from the front panel:

1. Make sure there is paper in the input tray or a roll loaded.

2. From the front panel, press .
3. Press Printer Maintenance > Clean Printhead.

To clean the printhead from the Embedded Web Server:

1. Make sure there is paper in the input tray or a roll loaded.
2. In the Embedded Web Server Tools tab, select Print Quality Toolbox > 

Clean Printhead, and follow the instructions on the screen.

To clean the printhead from the HP Utility

1. Make sure there is paper in the input tray or a roll loaded.
2. In the Support tab of the HP Utility, select Printhead Cleaning, and follow the 

instructions on the screen.
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Aligning the Printhead
Precise printhead alignment is essential for accurate colors, smooth color 
transitions, and sharp edges in graphical elements. Your printer has an automatic 
printhead alignment process which runs whenever a printhead has been accessed 
or replaced.

You may need to align the printhead after a paper jam or if you are experiencing 
print-quality problems.

CAUTION!CAUTION!
Do not use transparent or semi-transparent paper to align the printhead.

To align the printhead:

1. Load the paper you want to use, see “General Paper Loading Tips” on page 3-
2. You can use a roll or a cut sheet; plain white paper is recommended.

2. Ensure the window is closed. A strong light source near the printer during 
printhead realignment can affect alignment.

3. Swipe down the dashboard on the front panel and press .
4. Press Printer Maintenance > Align Printhead. If the loaded paper is 

satisfactory, the printer runs the realignment and prints a realignment pattern. 
The process takes about five minutes. 

Note: Printhead alignment can also be started from the Embedded Web Server 
(Tools > Print Quality Toolbox > Align Printhead), or from the HP Utility 
(Support > Printhead Alignment).

5. Wait until the front-panel display shows the process complete before using the 
printer.

Note: If the printer cannot complete the printhead alignment successfully, you 
may be asked to clean the printhead and try again.
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Replacing the Printhead
When the printhead has been replaced, the printer will automatically perform a 
printhead alignment on the loaded paper. If you want to perform the printhead 
alignment on a different paper (e.g., from the multi-sheet tray), change the paper 
before starting this procedure. Plain white paper is recommended.

The following QR code image contains a link to a video to get more information 
about how to replace a printhead. 

Important
Do not open any covers during this process.

To replace the printhead:

1. Turn on the printer.
2. If your printer is on a stand, make sure the printer wheels are locked (brake 

lever is pressed down) to prevent the printer from moving.

3. Swipe down the dashboard on the front panel and press .
4. Scroll down the menu and select Printer Maintenance > Replace Printhead.
5. Open the printhead door.

6. Locate the tubes connector lever (blue) to release the ink tubes. 
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7. Raise the blue lever to release the tube connector [1] and store the tubes 
connector on the holder in the printer door [2]. Make sure the ink tubes are 
secured in the door [3].

8. Locate the printhead lever (white).

9. Raise the lever to release the printhead. 

[1]

[2]

[3]
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10. Remove the printheads. 

CAUTION!CAUTION!
Handle with care to avoid getting ink on the connections.

11. Insert the new printhead [1] and lower the white printhead lever [2].

12. Insert the tubes connector into the printhead and make sure it locks.

13. Close the door and follow the instructions on the front panel. to perform a 
printhead alignment. The printer will prepare the printhead for use. This takes 
about 6 minutes.

[1]

[2]

[1]

[2]
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Calibrating the Paper Advance
Accurate paper advance is important to image quality because it is part of 
controlling the proper placement of dots on the paper. If the paper does not 
advance the correct distance between printhead passes, light or dark bands may 
appear in the print and image grain may increase.

The printer is calibrated to advance correctly with all paper types that display in the 
front panel. When you a paper type (of loaded paper), the printer adjusts the rate 
at which to advance the paper while printing. 

If you are not satisfied with the default calibration of your paper, you may need to 
recalibrate the rate at which the paper advances. See Troubleshooting print-
quality issues on page 135 to determine whether paper advance calibration will 
solve your issue.

Recalibrating Paper Advance

1. Swipe down the dashboard on the front panel and touch , 
2. Scroll down the menu and touch Printer maintenance > Paper advance 

calibration > Calibrate paper. The printer automatically recalibrates the 
paper advance and prints a paper advance calibration image which you can 
send to the stacker or basket.

3. Wait until the front panel displays the status screen, then re-print your print.

Note: The recalibration procedure takes approximately three minutes. Do not 
worry about the paper advance calibration image. The front-panel display 
shows any errors in the process.

4. If you are satisfied with your print, continue using this calibration for your 
paper type. If you see improvement in your print, continue with the next step. If 
you are dissatisfied with the recalibration, return to the default calibration, see 
"Return to Default Calibration," page 5-13.

5. To fine-tune the calibration or if you are using a transparent paper, swipe down 

the dashboard and touch , then scroll down the menu and touch Image 
quality maintenance > Paper advance calibration > Adjust paper 
advance.

6. Select the percentage of change from –99% to +99%. 
- Light banding: Decrease the percentage. 
- Dark banding: Increase the percentage.

7. Touch OK on the front panel, to save the value.
8. Wait until the front panel displays the status screen and reprint your print.
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Return to Default Calibration
Returning to the default calibration sets all the corrections made by the paper 
advance calibration to zero. To return to the default paper advance calibration 
value, you must reset the calibration. 

1. Swipe down the dashboard on the front panel and touch ,
2. Scroll down and touch Image Quality Maintenance > Paper advance 

calibration > Reset ready paper calibration.
3. Wait until the front panel displays the operation has completed successfully.

Move or Store the Printer
Your printer can be disassembled from the stand to move it. Use the blue knob to 
perform this operation. If you need to move or store the printer, prepare it correctly 
to avoid possible damage to it. 

To prepare the printer for moving or storing:

1. Do not remove the ink cartridges or printhead.
2. Remove any loaded paper.
3. On the left of the front panel, press Power to turn off the printer.
4. Unplug the power cord connected to the printer.
5. Disconnect any cables connecting the printer to a network or a computer.

CAUTION!CAUTION!
If you turn the printer upside down, ink could escape into the printer and cause 
serious damage.

Note: When the printer is turned back on, it takes about three minutes to 
initialize itself and to check and prepare the printhead. Preparing the printhead 
normally takes just over a minute. However, if the printer has been off for a six 
weeks or more, preparing the printhead could take up to 45 minutes.

CAUTION!CAUTION!
If the printer remains off for a long period of time, the printhead may become 
unusable. In this case, you need to replace the printhead with a new one.

Preparing and purging the printhead uses both time and ink. To maintain the 
printhead health, we strongly recommend that you leave the printer on or in sleep 
mode, whenever possible. In both cases, the printer will wake from time to time to 
maintain the printhead. Thus you can avoid going through lengthy preparation 
processes before using your printer.
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Software and Firmware Updates

Firmware Updates
There are various ways of downloading and installing firmware updates; you can 
choose whichever you find most convenient.

The following QR code image contains a link to a video to get more information 
about updating your firmware. 

Note: A firmware update package can be large; you should consider whether there 
are any implications for your network or Internet connection.

• You can configure the printer to download firmware updates automatically 
whenever they become available: see “Automatic Firmware Update” on 
page 2-15.

The following options are available if you choose manual firmware updates.

Update from Front Panel

1. Swipe down the dashboard on the front panel and touch ,
2. Scroll down the menu and touch Web Services setup > Product Update. 
3. Touch Check Now to check whether new firmware is available. If new 

firmware is available, you are given the opportunity to download and install it.

Update from Embedded Web Server
1. Select Firmware Update.

Update from HP Designjet Utility
1. In the HP Designjet Utility in Windows, select your printer from the Admin tab.
2. Follow the steps in the Firmware Update. section.
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Using a USB Pen Drive
1. Download the corresponding file from the web at 

http://www.hp.com/go/T830/support.
2. Copy the file to the root of the USB pen drive.
3. Plug in the USB host and wait until the front panel shows a new icon.

Important
This can take about 30 seconds.

4. When displayed, touch the icon Update Printer and follow the instructions on 
the front panel.

Note: The firmware includes a set of the most commonly used paper presets.

Software Updates
Under Windows, you are normally offered software updates automatically. For 
manual updates of printer drivers and other software for your printer, go to 
http://www.hp.com/ go/T520/drivers.

Printer Maintenance Kits
Two maintenance kits are available for your printer. The kits contain components 
that may need to be replaced after long use. When one of them is needed, a 
message is displayed on the front panel and by the HP Utility.

When you see the message, you should contact your Varitronics Dealer and 
request the maintenance kit. The kits are installed by service technicians only.
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Scanner Maintenance

Clean the Scan Bars
The following QR code image contains a link to a video to get more information 
about cleaning and replacing the scan bar.

Note: You should clean the scan bars periodically, depending on how often you 
use the scanner.

1. On the left of the front panel, press Power  to turn off the printer.
2. Turn off the power switch at the rear, and disconnect the power cord 

connected to the printer.
3. Press the two small indented buttons at the front of the scanner to open the 

scanner cover.

WARNING
Take care while the scanner lid is open to avoid trapping or crushing your 
fingers or hand.

4. Lift the scanner cover. 
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5. Clean the scan bars and the surrounding area with a lint-free cloth.

6. For more thorough cleaning, clean the calibration surfaces and the feed 
rollers.

7. Close the scanner cover and gently push it down to lock it into place.

8. Clean the area immediately in front of the scanner, where the scanned sheet 
rests before scanning.

9. Reconnect the power cable, turn on the power switch at the rear, and press 

Power  to turn on the printer.
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Calibrate the Scanner
Your scanner has been calibrated at the factory and should not need recalibration 
during their lifetimes. However, because of environmental changes, the scanner 
may start showing image defects that can be easily corrected by recalibrating the 
scanner. 

The procedure takes less than 10 minutes, and we recommend that you 
recalibrate the scanner whenever undesired artifacts or a lack of quality in 
scanned files or copies appears.

Note: Keep in mind the limitations of CIS technology. Scanners based on CIS 
technology have a high optical resolution within their focus plane, at the price of a 
very limited depth of field. Hence, the images are sharp and detailed when the 
scanned original is perfectly flat against the glass plate. However, whenever the 
original contains wrinkles or folds, these defects are clearly visible in the scanned 
image (as shown in the following example). 

If you perform calibration successfully and still have concerns about the image 
quality, please read “Troubleshooting Scan and Copy Issues” on page 6-32 in 
order to detect whether you are facing a product limitation, and may want to 
consider buying a CCD scanner. 

To calibrate the scanner:

1. Clean the scanner. See “Clean the Scan Bars” on page 5-16.

2. Swipe down the dashboard on the front panel and touch ,
3. Scroll down the menu and touch Image Quality Maintenance and touch 

Alignment calibration. 
4. Follow the instructions in the front panel.

If calibration fails:

1. Verify the printer is turned on and ready for normal operation.
2. Verify the scanner is working correctly. To test it, scan a small document to file.
3. Verify the scanner is clean before calibration. If in doubt, clean the scanner 

and restart the calibration process.
4. Eject and reload the calibration sheet, checking that it is clean, in good 

condition, face up and perfectly centered in the scanner.
5. If the previous steps do not help, eject the sheet and restart the printer (turn off 

and on). When the system has restarted, repeat the calibration.

Note: If you cannot perform the calibration successfully in three consecutive 
attempts, contact your Varitronics Dealer for support. 



VariQuest® Perfecta® 2400STP User’s Guide 6-1

6 Troubleshooting

This chapter provides information about troubleshoot the VariQuest® Perfecta® 2400STP 
Poster Design System. The following information is contained in this chapter:

• “Troubleshooting Paper Issues” on page 6-2
• “Paper Loading Error Messages” on page 6-4
• “Paper Type Missing from Printer Driver” on page 6-5
• “Troubleshooting Paper or Paper Quality Issues” on page 6-6
• “Troubleshooting Print Quality Issues” on page 6-14
• “Troubleshooting Scanner Printing Issues” on page 6-31
• “Troubleshooting Scan and Copy Issues” on page 6-32
• “Scanner Diagnostic Plot” on page 6-55
• “Troubleshooting Ink Cartridge and Printhead Issues” on page 6-62
• “Troubleshooting Data Communication Issues” on page 6-64
• “Network Configuration Page” on page 6-71
• “Troubleshooting General Printer Issues” on page 6-74
• “Front Panel Error Messages” on page 6-77
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Troubleshooting Paper Issues 

Troubleshooting Paper Issues
Problem Suggested Action

Paper cannot be loaded 
successfully.

• Check that no paper is already loaded.
• Ensure that the paper is far enough inside the printer, you should 

feel the printer grab the paper.
• Do not attempt to straighten the paper during the aligning process, 

unless instructed to do so by the front-panel display. The printer 
automatically attempts to straighten the paper.

• The paper may be crumpled, or warped, or may have irregular 
edges.

Unsuccessful Roll Load • Check that the roll is at least 11 inches wide: narrower rolls are not 
supported.

• Check the leading edge of the paper: if it is not straight or clean, it 
should be trimmed. Remove the initial 1 inch from the roll and try 
again. This may be necessary even with a new roll of paper.

• Check that the roll ends are tight against the spindle ends.
• Check that the spindle is correctly inserted.
• Check that the output tray is closed. The roll will not load when it 

is open.
• Check that the paper is correctly loaded on the spindle, and that it 

loads over the roll toward you.
• Check that all roll end plugs have been removed.
• Check that the paper is wound tightly on the roll.
• Do not touch the roll or paper at during the alignment process.
• If the paper has not been inserted straight, follow the instructions 

on the front panel.
• To start the load process again, cancel the process on the front 

panel and rewind the roll from the end of the spindle until the edge 
is removed from the printer.

Note: If the roll has become loose around the core, the printer 
cannot load the paper.
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Unsuccessful Sheet Load • Check that the sheet is more than 12.95 inches wide (A3+). If it is 
that width or less, load it from the multi-sheet tray.

• Guide the sheet, especially thick papers, when the printer initially 
feeds the sheet.

• Ensure that the sheet is aligned with the reference line on the roll 
cover.

• Do not attempt to straighten the sheet during the loading process, 
unless instructed to by the front panel display.

• Do not use hand-cut sheets, which may be of irregular shapes. 
Use only purchased sheets.

Note: In case of any problems, follow the instructions on the front-
panel display.

• To start the load process again, cancel the process on the front 
panel; the printer ejects the sheet from the front of the printer.

Unsuccessful Load from Multi-
Sheet Tray

• Check that you have not loaded too many sheets into the tray. The 
maximum number of sheets depends on the paper thickness: 
approximately 50 sheets of plain, standard paper.

• Check that sheets are correctly loaded into the tray.
• Check that sheets are correctly adjusted and centered in the tray.
• Check that you have extended the input and output trays correctly: 

the first extension for A4, the second for A3 paper.

• If the paper is hanging over the back of the input tray as shown, it 
may fail to load.

Note: Avoid leaving sheets of paper loaded in the printer for a 
significant length of time, because they will deform.

Troubleshooting Paper Issues (Continued)
Problem Suggested Action
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Paper Loading Error Messages 

Paper Loading Error Messages
Message Suggested Action

Paper loaded with too much 
skew.

• During the paper load process the printer detected that the paper 
had too much skew. Press OK to unload the roll automatically, 
then restart the process.

Paper not detected. • During the paper load process the printer did not detect any paper. 
Verify the paper is inserted fully and is not transparent.

Paper too far from lateral edge. • Reload the cut sheet, aligning the right edge against the black stop 
on the spindle.

Paper load failed. Paper width is 
smaller than the minimum size 
supported by the selected paper 
source.

• Paper width is smaller than the minimum size supported by the 
selected paper source.

• Cut sheets smaller than ISO A3 must be loaded using the multi-
sheet tray.

Sheet too big. • During the load process the printer detected that the sheet of 
paper is either too wide or too long to be loaded correctly. 

Sheet too small. • During the load process the printer detected that the sheet of 
paper is too narrow or too short to be loaded in the printer. 
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Paper Type Missing from Printer Driver 
To work with a paper not in the driver, you can use your paper as one of the 
presets already in the driver, however, you must identify whether your paper is 
transparent or translucent, photo or bond, coated or technical.

Note: For glossy paper, it is important to select a glossy paper type, as the printer 
adjusts its ink use for glossy paper. 

Transparent or Translucent Film
Paper Type Suggested Action

Transparent (e.g., transparency) • Select paper type Film > Transparent/Clear film.
Translucent (e.g., technical 
paper)

• Select paper type Film > Matte film.

Photo Paper
Paper Type/Finish Suggested Action

Photo Paper • Use the Photo Paper category.
Glossy/High Gloss Paper • Select paper type Photo Gloss Paper.
Semi-Gloss/Satin/Pearl/Luster 
Finish

• Select paper type Photo Semi-gloss/Satin Paper.

Note: To increase gamut on photo paper, select paper type HP 
Universal Gloss Photo Paper or HP Universal Satin Photo 
Paper, depending on the finish.

Bond and Coated or Technical Paper
Note: Your paper type selection for generic paper depends on the absorption capacity of the paper’s ink.

Paper Type/Finish Suggested Action
Natural Tracing Papers • Select paper type Natural Tracing Paper < 65 g/m2 or Natural 

Tracing Paper > 65 g/m2, depending on the weight of the paper.
Thin Papers (<90 g/m2) or 
uncoated papers (e.g., plain paper 
or bright white paper)

• Select paper type Bond and Coated Paper > Plain Paper. You 
can also select Recycled Bond Paper.

Light-coated Papers (<110 g/m2) • Select paper type Bond and Coated Paper > HP Coated 
Paper.

Heavyweight Coated Papers 
(<200 g/m2)

• Select paper type Bond and Coated Paper > Heavyweight 
Coated Paper.
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Troubleshooting Paper or Paper Quality Issues

Ink or Wrinkling Problems
Problem Suggested Action

Black ink is easily removed when 
touched.

This happens when your paper is incompatible with matte black 
ink. To use an optimized ink combination:

• Select paper type Photo Paper > Photo Gloss Paper.
After printing, the paper has 
wrinkles or there is too much ink.

This happens when too much ink is used. To use less ink, select a 
thinner category. 
Matte paper categories from thinnest to thickest are:

• Plain Paper
• Coated Paper
• Heavyweight Coated Paper

For other image quality problems, see “Troubleshooting Paper or 
Paper Quality Issues” on page 6-6.

Wrong Paper Type Printed
Problem Suggested Action

The printer prints your job before 
you were able to load your 
desired paper.

In the printer driver, you may have Any selected for the Paper 
Type. When Any is selected, the printer will print immediately on 
whichever paper is loaded. 
Load your desired paper, see “Loading Paper” on page 3-3, and 
select your paper type specifically in the driver.

• In the Windows driver dialog: select the Paper/Quality tab.
• Select your paper type from the Paper Type list.

Note: Any is the driver default.

Paper Mismatch
Problem Suggested Action

Printer stops or stays in wait 
mode.

If the paper currently loaded is not suitable for a particular job, the 
printer stops and waits for you to decide what to do. Loaded paper 
may be considered unsuitable if:

• the paper type is not as specified for the job.
• the paper source (roll, multi-sheet tray, or manual feed) is not as 

specified for the job.
• the paper size is smaller than specified for the job.

If you do not specify these settings for a particular job, the printer 
will print on whatever paper is loaded. If the printer stops for a 
paper mismatch, you can choose one of these options:

• Load the correct paper and resume printing.
• Print the job on the currently-loaded paper. The print may be 

clipped if the paper is not large enough.
• Cancel the job.
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Paper Jams
Problem Suggested Action

Paper Roll Jammed. When a paper jam occurs, a message normally displays on the 
front panel.
1. Open the top cover.

2. Rewind the roll. You may feel resistance if the paper is stuck; 
pull firmly.

3. Cut the paper if needed

4. Rewind the roll.

5. Carefully remove any of the jammed paper that you can lift up 
and out from the top of the printer.
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6. Open the front window.

7. Try to move the printhead carriage out of the way .
8. Carefully remove any of the jammed paper that you can from 

the front window.

Take care not to damage printer's inside components.
Do not move the paper sideways, as it could damage the 
printer.

9. Close the front window.

10. Close the roll cover.

11. Reload the roll or load a new sheet; see Paper handling on 
page 33 

Paper Jams (Continued)
Problem Suggested Action
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Single-sheet paper has jammed. 1. Remove the single sheet from the printer.

2. Open the front cover.

3. Remove any of the jammed paper.

4. Close the front cover.

Paper Jams (Continued)
Problem Suggested Action
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The multi-sheet tray has jammed. 1. Remove as much paper as you can from the multi-sheet tray.
2. Push down the multi-sheet tray extenders, making it easier to 

handle.
3. Unlock the tray using the rotary switch behind it.

4. Pull out the tray.

5. Remove all paper from the tray.

6. Remove all paper from the printer.

7. Replace the tray.
8. Lock the tray.

Paper Jams (Continued)
Problem Suggested Action
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Paper Output Problems
Problem Suggested Action

A strip stays on the output trays 
and generates jams.

If a small piece of paper has been cut, such as before printing a 
new roll, or after the front panel option Form feed and cut has 
been used, the cut strip may remain in the output tray. 
1. When the printer is not printing, reach into the tray and 

remove the strip.

The printer displays out of paper 
when paper is available.

If the roll becomes loose from its core, it will not feed correctly and 
the printer will not load the paper. If possible, tighten the paper to 
its core or load a new roll.

Prints do not fall neatly into the 
bin.

• Ensure the bin is correctly installed.
• Ensure the bin is open.
• Ensure the bin is not full.

Paper often tends to curl near the end of a roll, which can cause 
output problems. 
1. Load a new roll, or remove prints manually as they are 

completed.
The sheet stays in the printer 
when printing is complete.

The printer holds the paper to allow the print to dry after printing, 
see “Change Drying Time” on page 3-14. 

• If the paper is only partially ejected after the drying time, gently 
pull the sheet out of the printer. 

• If the automatic cutter is disabled, use the Form feed and cut 
option in the front panel, see “Use Form Feed With or Without 
Cutting” on page 3-16.

The paper is automatically cut 
when printing is complete.

By default, the printer cuts the paper after the drying time has been 
completed, see “Change Drying Time” on page 3-14. 
To disable the cutter, see “Change Cutter Settings” on page 3-15.

The cutter does not cut well. By default, the printer is set to cut the paper automatically after the 
drying time has been completed.
If the cutter is turned on but not cutting correctly:

• Check that the cutter rail is clean and clear of any obstacles.
• Check that there are no pieces of paper in the cutter groove.

The roll is loose on the spindle The roll may need to be replaced or reloaded.
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Scanner Problems
Problem Suggested Action

The scanner does not load the 
original.

If you have difficulty loading the original when scanning, try the 
following:
1. Check that the unit is on.
2. Wait until the unit has booted up completely and is idle.
3. Check for messages in the Touch Panel.
4. If you completed the previous steps, verify that the original 

meets the scanner specifications.
5. Make sure you are loading the original far enough into the 

scanner so that it can be detected.
6. Make sure the leading edge of the original is flat and the is 

even when loading it. If not, trim the leading edge so the media 
enters the scanner smoothly.

7. Try using a different media type to eliminate the scanner 
hardware as an issue. 

Scanner is jammed. When a paper jam occurs, a message normally appears on the 
front-panel display. To clear a scanner paper jam:
1. Open scanner lid.

2. Pull paper out from one of the following paths:
- Top-rear area at the back.

- Front bottom area between scanner platen and front window.
Do not move the paper sideways as it could damage the 
scanner.
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3. Using your fingers, you can turn the rubber wheels to get better 
access to the paper and clear any debris. 

4. Close the scanner lid.

Scanner Problems (Continued)
Problem Suggested Action



6-14 VariQuest® Perfecta® 2400STP User’s Guide

Troubleshooting Print Quality Issues

Troubleshooting Print Quality Issues

General Printing Tips
Problem Suggested Action

When you have any print-quality 
problems:

• To achieve the best performance from your printer, use only 
genuine manufacturer's supplies and accessories, whose 
reliability and performance have been thoroughly tested to give 
trouble-free performance and best-quality prints. 

• Make sure the paper type selected in the front panel is the same 
as the paper type loaded into the printer (see “View Paper 
Information” on page 3-13). Also make sure that the paper type 
selected in your software is the same as the paper type loaded into 
the printer.
If you have the wrong paper type selected, you could 
experience poor print quality and incorrect colors, and 
possibly damage the printhead.

• Check that you are using the most appropriate print-quality 
settings for your purposes (see “Printing” on page 4-1). You are 
likely to see lower print quality if you moved the print-quality slider 
to the 'Speed' end of the scale, or set the custom quality level to 
Fast.

• Check that your environmental conditions (temperature, humidity) 
are in the recommended range. See “Environmental 
Specifications” on page 7-6.
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Horizontal Banding
Problem Suggested Action

Horizontal lines across the image. If your printed image has added horizontal lines as shown (Note: 
The color may vary.):

1. Check that the paper type you have loaded corresponds to the 
paper type selected in the front panel and in your software. 
See “View Paper Information” on page 3-13.

2. Check that you are using appropriate print-quality settings for 
your purposes (see “Printing” on page 4-1). In some cases, 
you can overcome a print-quality problem by selecting a 
higher print-quality level. For instance, if you set the Print 
Quality slider to Speed, try setting it to Quality.

3. Print the Print Diagnostic Report. See “Print Quality Diagnostic 
Report” on page 5-6. 

4. If printhead is working correctly, perform the paper advance 
calibration: see “Calibrating the Paper Advance” on page 5-12.

5. If the problem continues to persist, contact your VariQuest 
dealer for further support.
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Incorrect Line Weight
Problem Suggested Action

Line weight on image incorrect. If your printed image has lines that are too thick, too thin or 
missing:

1. Check that the paper type you have loaded corresponds to the 
paper type selected in the front panel and in your software. 
See “View Paper Information” on page 3-13.

2. Check that you are using appropriate print-quality settings for 
your purposes (see “Printing” on page 4-1). Select the custom 
print-quality options in the driver dialog, and try turning on the 
Maximum detail option (if available).

3. If the resolution of your image is greater than the printing 
resolution, you may notice a loss of line quality. See the Max. 
Application Resolution option in the driver dialog's Advanced 
tab, under Document Options > Printer Features.

4. If lines are too thin or missing, print the Print Quality 
Diagnostic Report. See “Print Quality Diagnostic Report” on 
page 5-6.

5. If the problem persists, perform paper advance calibration: see 
“Calibrating the Paper Advance” on page 5-12.

6. If the problem continues to persist, contact your VariQuest 
dealer for further support.
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Jagged-Edged Lines
Problem Suggested Action

Lines have jagged edges. If your printed image has lines that appear stepped or jagged 
when printed:

1. The problem may be inherent in the image. Try to improve the 
image with the application you are using to edit it.

2. Check that you are using appropriate print-quality settings. 
See “Printing” on page 4-1.

3. Select the custom print-quality options in the driver dialog, and 
turn on the Maximum detail option (if available).

Lines Print Double or Wrong Color
Problem Suggested Action

Lines print out double or in the 
wrong color.

This problem can have various visible symptoms:
• Colored lines are printed double, in different colors.
• Borders of colored blocks are colored wrong.

To correct this kind of problem:
1. Print the Print-Quality Diagnostic Report. See “Print Quality 

Diagnostic Report” on page 5-6.
2. Align the printhead if recommended in the report.
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Discontinuous Lines
Problem Suggested Action

Lines are broken or not 
continuous.

If your lines are broken:

1. Check that you are using appropriate print-quality settings. 
See “Printing” on page 4-1.

2. Print the Print-Quality Diagnostic Report. See “Print Quality 
Diagnostic Report” on page 5-6.

3. Align the printhead if recommended in the report.
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Blurred Lines
Problem Suggested Action

Lines are blurred. Humidity can cause ink to soak into the paper, making the lines 
blurred and fuzzy. 

Try the following:
1. Check that your environmental conditions (temperature, 

humidity) are suitable for high-quality printing. See 
“Environmental Specifications” on page 7-6.

2. Check that the paper type selected in the front panel is the 
same as the paper type you are using. See “View Paper 
Information” on page 3-13.

3. Try changing to a heavier paper type.
4. Select a lower print quality (such as Speed); the printer will 

then use less ink.
5. Select a paper type that is slightly thinner than the paper you 

have loaded; this will persuade the printer to use less ink. 
Example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper.

6. If you are using glossy paper, try changing to a different type of 
glossy paper.

7. Print the Print-Quality Diagnostic Report. See “Print Quality 
Diagnostic Report” on page 5-6.

8. Align the printhead if recommended in the report.



6-20 VariQuest® Perfecta® 2400STP User’s Guide

Troubleshooting Print Quality Issues

Inaccurate Line Lengths
Problem Suggested Action

Length of printed lines is not 
accurate.

If your printed line lengths are not accurate for your purposes, you 
can try to improve line length accuracy.
1. Print on Matte Film, for which your printer's line length 

accuracy is specified. See “Functional Specifications” on 
page 7-2.

2. Polyester film is about ten times more dimensionally stable 
than paper. However, using film that is thinner or thicker than 
Matte Film will reduce line length accuracy.

3. Set the Print Quality slider to Quality.
4. Maintain the room at a steady temperature between 10 and 

30°C (50 and 86°F).
5. Load the roll of film and let it rest for five minutes before 

printing.
6. If you are still not satisfied, try recalibrating the paper advance. 

See “Calibrating the Paper Advance” on page 5-12.
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Blurred or Grainy Image
Problem Suggested Action

The whole image is blurry or 
grainy.

1. Check that:
• The loaded paper type corresponds to the paper type selected in 

the front panel and in your software. See “View Paper 
Information” on page 3-13.

• You are printing on the correct side of the paper.
• You are using appropriate print-quality settings (see “Printing” on 

page 4-1). In some cases, you can overcome a print-quality 
problem by selecting a higher print-quality level. For instance, if 
you have set the Print Quality slider to Speed, try setting it to 
Quality.

2. Print the Print-Quality Diagnostic Report. See “Print Quality 
Diagnostic Report” on page 5-6.

3. Align the printhead if recommended in the report.
4. If the problem persists, perform paper advance calibration: see 

“Calibrating the Paper Advance” on page 5-12.
5. If the problem continues to persist, contact your VariQuest 

dealer for further support.
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Paper Rippled
Problem Suggested Action

The paper is not flat after printing. If the paper does not lie flat when it comes out of the printer, but 
has shallow waves in it, you are likely to see defects in the printed 
image, such as vertical stripes. This can happen when you use 
thin paper that becomes saturated with ink.

1. Check that the paper type loaded corresponds to the paper 
type selected in the front panel and in your software. See 
“View Paper Information” on page 3-13.

2. Try changing to a thicker paper type such as a heavy, coated 
paper.

3. Select a lower print quality (e.g., Speed); the printer will then 
use less ink.

4. Select a paper type that is slightly thinner than the paper you 
have loaded; this will persuade the printer to use less ink. 
Example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper.
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Print Scuffed or Scratched
Problem Suggested Action

The paper is scuffed or scratched 
when it comes out of the printer.

The black ink pigment can be scuffed or scratched when touched 
by a finger, a pen or some other object. This is particularly 
noticeable on coated paper.
Glossy paper may be extremely sensitive to the bin or to anything 
else that it contacts soon after printing, depending on the amount 
of ink used and the environmental conditions at the time of 
printing.
To reduce the risk of scuffs and scratches:

• Handle prints carefully.
• Avoid stacking prints on top of each other.
• Catch your prints as they are cut from the roll and do not let them 

fall into the bin. Alternatively, leave a sheet of paper in the bin so 
that freshly printed sheets do not make direct contact with the bin.

To increase the drying time: 

1. At the front panel, press .
2. Press Printer Preferences>Print Retrieval>Select drying 

time >Extended.
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Ink Marks on Paper
Problem Suggested Action

Horizontal smears on the front of 
coated paper.

If a lot of ink is used on plain or coated paper, the paper absorbs 
the ink quickly and expands. As the printhead moves over the 
paper, the printhead may come into contact with the paper and 
smear the printed image. This problem is normally seen only on 
cut sheets of paper (not on roll paper).

If you notice this problem, immediately cancel the printing 
job. Press  and also cancel the job from your computer 
application. Soaked paper can damage the printhead.

If you notice poor print quality after canceling a print job due to 
smearing, clean the printhead. See “Cleaning the Printhead” on 
page 5-7.
To avoid this problem:
1. Check that the paper type loaded corresponds to the paper 

type selected in the front panel and in your software. See 
“View Paper Information” on page 3-13.

2. Use a recommended paper type and the correct print settings.
3. If using sheet paper, try rotating the sheet 90 degrees. The 

orientation of the paper fibers may affect performance.
4. Try changing to a thicker paper type, such as heavyweight 

coated paper.
5. Select a paper type that is slightly thinner than the paper you 

have loaded; this will persuade the printer to use less ink. 
Example paper types in ascending order of thickness: Plain 
Paper, Coated Paper, Heavyweight Coated Paper.

6. Try to increase the margins by relocating the image to the 
center of the page using your software application.

Ink marks on the back of the 
paper

• Clean the platen with a soft cloth. 
• Clean each rib separately.
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Black Ink Rubs Off
Problem Suggested Action

Black ink comes off when you 
touch the print.

This problem may be caused by printing with matte black ink on 
glossy paper. The printer will not use matte black ink if it knows 
that the paper will not retain it. 
To avoid matte black ink, you select Photo Glossy Paper as the 
paper type (in the Photo Paper category).

Object Edges Not Sharp
Problem Suggested Action

The edges of objects are stepped 
or not sharp.

If edges of objects or lines appear to be poorly defined or lighter in 
density and you have already set the print-quality slider to Quality 
in the driver dialog:

1. Select the custom print-quality options.
2. Try setting the quality level to Speed. See “Printing” on 

page 4-1.
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Object Edges Dark
Problem Suggested Action

The edges of objects are darker 
than expected.

If edges of objects seem darker than expected, and you have 
already set the print-quality slider to Quality in the driver dialog:

1. Select the custom print-quality options.
2. Try setting the quality level to Speed. See “Printing” on 

page 4-1.

Vertical Lines Different Color
Problem Suggested Action

Print has vertical bands of 
different colors along it.

1. Try using thicker paper, choosing from the recommended 
paper types such as heavyweight coated paper.

2. Try using higher print-quality settings (see “Printing” on page 4-
1). For example, if the Print Quality slider is set to Speed, try 
setting it to Quality.

White Spots on Print
Problem Suggested Action

White spots appear on the printed 
paper.

This is probably due to paper fibers, dust or loose coating material. 
To avoid this problem:
1. Try cleaning the paper manually with a brush before printing, 

to remove any loose fibers or particles.
2. Always keep the cover of your printer closed.
3. Protect your paper rolls and sheets by storing them in bags or 

boxes.



VariQuest® Perfecta® 2400STP User’s Guide 6-27

Troubleshooting Print Quality Issues

Inaccurate Colors
Problem Suggested Action

Printed colors are not correct. If the colors of your print do not match your expectations, try the 
following:

1. Check that the paper type loaded corresponds to the paper 
type selected.

2. Check that you are printing on the correct side of the paper.
3. Check that you are using appropriate print-quality settings. For 

the most accurate colors, select Normal or Best quality.
4. Print the Print Quality Diagnostic Report. See “Print Quality 

Diagnostic Report” on page 5-6.

Colors Fading
Problem Suggested Action

Printed colors fade quickly. If you print on instant-dry photo paper, your prints will fade rapidly. 
If you plan to display the prints for more than two weeks, you 
should laminate them to achieve longer life.
Prints on coated paper that can swell will fade much less rapidly. 
However, lamination will increase the life of prints (depending on 
the type of lamination) with all paper types. 
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Image is Incomplete
Problem Suggested Action

The image is clipped at the 
bottom.

Check the following:
• If you pressed  before all the printer received all of the data, you 

ended the data transmission and will have to print the page again.
• The I/O timeout setting may be too short. This setting determines 

how long the printer waits for the computer to send more data, 
before deciding that the job is finished. Change the timeout 
setting, then send the print again: from the front panel, increase 

the I/O timeout setting to a longer period by pressing , then 
Connectivity > Advanced Setup > Select I/O Timeout.

• There may be a communications problem between your computer 
and the printer. Check your USB or network cable, or your WiFi 
connection.

• Check to make sure that your software settings are correct for 
your current page size (e.g., long-axis prints).

• If you are using network software, make sure it has not timed out.
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Image is Clipped
Problem Suggested Action

The image is clipped when 
printed.

Clipping normally indicates a discrepancy between the actual 
printable area on the loaded paper and the printable area as 
understood by your software.

• Check the actual printable area for the paper size you have 
loaded (printable area = paper size – margins).

• Check the printable area of your software (may be called "printing 
area" or "imageable area"). For example, some software 
applications assume standard printable areas that are larger than 
those used in this printer.

• If you defined a custom page size with very narrow margins, the 
printer may impose its own minimal margins, clipping your image 
slightly. You may want to consider using a larger paper size.

• If your image contains its own margins, you may be able to print 
it successfully by using the Clip Contents by Margins option 
(see “Choose Margins Options” on page 4-8).

• If you are trying to print a very long image on a roll, check that your 
software is capable of printing an image of that size.

• You may have tried to rotate the page from portrait to landscape 
on a paper size that is not wide enough.

• If necessary, reduce the size of the image or document in your 
software application, so it fits between the margins.

There is another possible explanation for a clipped image. Some 
applications, such as Adobe Photoshop, Adobe Illustrator and 
CorelDRAW, use an internal 16-bit coordinate system which 
means that they cannot handle an image of more than 32,768 
pixels.

Note: An image 32,768 pixels long would print at a length of 54.61 
inches if you select Best or Quality in the driver. If you select Fast, 
Normal or Speed, that same image will print 109.23 inches.

If you try printing an image larger than this from these applications, 
the bottom of the image may be clipped. To print the whole image, 
try these suggestions:

• The driver dialog includes an option called Max. application 
resolution, which enables you to print successfully in this 
situation. You do not normally need to change the default setting 
(Auto). However, you can find the option in the Advanced tab, 
under Document Options > Printer Features.

• Save the file in another format, such as TIFF or EPS, and open it 
with another application.

• Use a RIP to print the file.
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Some Objects Missing from Image
Problem Suggested Action

Some objects are missing from 
the printed image.

Large quantities of data may be necessary to print a high-quality 
large-format print job, and in some specific workflows there may 
be issues that can lead to some objects missing from the output.
Tips to help avoid this problem.

• Tell the HP-GL/2 driver to send the image as a bitmap.
• Select a smaller page size and scale to the desired final page size 

in the driver or in the front panel.
• Save the file in another format, such as TIFF or EPS, and open it 

with another application.
• Use a RIP to print the file.
• Reduce the resolution of bitmap images in your application 

software.
• Select a lower print quality to reduce the resolution of the printed 

image.
These options are suggested for troubleshooting purposes 
and may adversely affect the final output quality or the time 
necessary to generate the print job. Therefore, they should 
be cancelled if they do not help to solve the problem.

PDF File Clipped or Missing Information
Problem Suggested Action

When printing a PDF file, some of 
the information is clipped or 
missing.

In older versions of Adobe Acrobat or Adobe Reader, large PDF 
files could be clipped or lose some objects when printing with the 
HP-GL/2 and HP RTL driver at high resolution. 
To avoid such problems, upgrade your Adobe Acrobat or Adobe 
Reader software to the latest version. These problems should be 
solved from version 7 and above.

Still Experiencing Problems
Problem Suggested Action

Still experiencing print-quality 
problems.

If you still experience print-quality problems after applying the 
advice in this section, try the following:

• Use a higher print-quality option. See “Printing” on page 4-1.
• Verify the driver you are using is the most current. Consult your 

VariQuest dealer for details. 
• Verify that your printer's firmware is up to date. See “Software 

and Firmware Updates” on page 5-14. Check that you have the 
right settings in your software application.
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Troubleshooting Scanner Printing Issues 

Scanner Printing Issues
Problem Suggested Action

Cannot access the network 
folder.

If you have set up a network folder (see “Scan to Network Setup 
Process” on page 4-24), but the printer cannot access it, check 
that:
• each field is filled in correctly.
• the printer is connected to the network.
• the remote computer is switched on, working normally and 

connected to the network.
• the folder is shared.
• you can put files into the same folder from a different computer 

on the network, using the printer's logon credentials.
• the printer and remote computer are in the same network 

subnet; if not, check that network routers are configured to 
forward the CIFS protocol traffic (also known as Samba).

Scanning to file is slow, Scanning large formats creates large files. This means that 
scanning to file can take time even under optimal system 
configurations and conditions. This is especially true when 
scanning across a network. However, if you think scanning to file 
with your system is unreasonably slow, try the following to locate 
and solve the problem.
• Check scan job status on front panel. If it takes too long, you 

can cancel it.
• Check that Resolution setting is right for the job. Not all 

scanning tasks require high resolutions. Lowering resolution 
will speed up the scanning process. For JPEG and PDF scan 
jobs, you can also change Quality. Lower quality values 
produce smaller files.

• Check network configuration. Your network should be a 
transfer rate of Gigabit Ethernet or higher to achieve optimal 
scanning speeds. Networks with a 10/100 Ethernet 
configuration have slower transfer rates.

• Contact your network administrator for information about your 
network configuration, transfer rates, scan-to-file destinations 
on the network and possible solutions for increasing speeds.

• If scanning to files on the network is too slow and the network 
configuration cannot be changed, improved speeds can be 
achieved by scanning to a USB flash drive.

• If scanning to a USB flash drive seems slow, check your USB 
flash drive interface compatibility. Your system supports a Hi-
Speed USB interface. Your USB flash drive should be 
compatible with Hi-Speed USB (i.e., USB 2). Also check that 
your USB flash drive contains enough storage space for 
scanned large-format images. 
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Troubleshooting Scan and Copy Issues
This section describes the most common copy & scan defects and failure modes, 
sorted by relevance and frequency of appearance. A defect is a common image 
artifact that usually appears when using any CIS scanner. These are due to 
incorrect settings, product limitations, or easily solvable mistakes. A failure mode 
is due to malfunctions of some of the scanner components.

Scanner cleanliness is paramount to ensure good image quality. Before 
proceeding with any troubleshooting, please make sure the glass scan bars are 
clean and in good condition and the pressure sliders (wide, white plastic parts) are 
also in good and clean condition.

Some of the corrective actions proposed here require the use of the Scanner 
Diagnostic Plot, which you can print and scan as indicated in The scanner 
diagnostic plot on page 167. When copying, to be sure that the defect does not 
come from the printing function, use this diagnostic plot to detect any scanning 
issue. 

CAUTION!CAUTION!
Do not use any printed version of this guide to test the scanner, as the resolution 
of the images included here is insufficient. Use the diagnostic plot when 
recommended in response to any of the errors described in this chapter.
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Copy and Scan Quality Issues
Problem Suggested Action

Random vertical lines. This is one of the most common issues in sheet-fed scanners. 
Usually, the vertical streaks are caused by dust particles inside the 
scanner, or mis-calibration of the scanner (in these cases, the 
problem can be solved). The examples show some images 
suffering from vertical lines or streaks (note the black arrow 
indicating the scanning direction in these examples).
1. Clean the scanner’s glass scan bars and the original to be 

scanned as described in “Clean the Scan Bars” on page 5-16. 
Re-boot the printer and re-scan your original.

2. If streaks remain, recalibrate the scanner as indicated in 
“Calibrate the Scanner” on page 5-18. Re-boot the scanner 
and re-scan your original after calibration is completed.

3. If the streaks still remain, check the scanner’s glass scan bars 
and sliders visually. If they are damaged (scratched or 
broken), contact your authorized VariQuest Dealer or 
VariQuest Customer Service.

Note: Vertical streaks cannot always be solved, due to the 
technological limitations of CIS technology. If the streaks remain 
after the corrective actions previously described, no further action 
can be taken to improve the image quality, except to buy a more 
expensive CCD scanner.
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Wrinkles or folds. Scanners based on CIS technology have a high optical resolution 
within their focus plane, at the price of a very limited depth of field. 
The images are sharp and detailed when the scanned original is 
perfectly flat against the glass plate. However, if the original 
contains wrinkles or folds, these defects are clearly visible in the 
scanned image (see example).

1. To correct:
• Scan: Re-scan the original and set the background color and 

noise removal to Off. 
• Copy: Set the content type to IMAGE.

2. If the problem persists:
• Scan: Re-scan the original at a lower scanner resolution (300 dpi 

or lower resolution.
• Copy: Set resolution to Fast or Normal

Note: It may also help to flatten the original manually as much as 
possible before scanning it again.

Note: Due to the technological limitations of CIS technology, the 
problem of wrinkles cannot always be solved. If the wrinkles remain 
after the corrective actions explained above, then no further action 
can be taken to improve the image quality, except to buy a more 
expensive CCD scanner.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Line discontinuities When scanning or copying large originals, you may sometimes 
find issues such as shown in the following image, where a straight 
line (does not have to be horizontal) appears with discontinuities or 
small steps. Note the black arrow indicating the scanning direction 
in this example.

To correct:
1. Repeat the scan, making sure the product is correctly 

positioned (i.e., flat on the floor and does not move). 

Note: Turning the original 90 or 180 degrees and scanning it again 
may also solve the problem.

2. If the problem persists, check that the original to be scanned is 
not skewed and that it does not become skewed during the 
scan. If so, see “Troubleshooting Scanner Printing Issues” on 
page 6-31. 

Note: Also try deactivating the automatic de-skew algorithm as 
indicated in “Troubleshooting Scanner Printing Issues” on page 6-
31.

3. If there is no skew but the problem persists, clean and 
calibrate the scanner as indicated in “Clean the Scan Bars” on 
page 5-16 and “Calibrate the Scanner” on page 5-18“Calibrate 
the Scanner” on page 5-18. 

4. Take care not to move the printer during the calibration, and 
check that the maintenance sheet is correctly positioned 
before starting the calibration. Also check that the 
maintenance sheet is not damaged before calibrating the 
scanner (an old or damaged maintenance sheet may cause 
this problem); if damaged, reprint it as explained in “Calibrate 
the Scanner” on page 5-18). 

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Problem persists. If the problem persists, analyze the following areas of the 
diagnostic plot:
•  D, H and L (for three modules, 0-Left, 1-Middle, and 2-Right 

and its intersection)
If you see any of these defects in the studied areas, contact your 
VariQuest dealer and report a “line discontinuities” error after 
calibration.

The four vertical thin black lines at the beginning and end of the 
diagnostic plot show, approximately, the position of the intersection 
between scan bars, where this kind of error usually appears. If the 
error appears outside these areas, contact your VariQuest dealer 
and report a “line discontinuities within a scan bar”. 

Light colored area fills are 
missing in the scan or copy.

When scanning or copying a map with a light area at the top, the 
Background color removal setting could interpret it as a 
background color, therefore removing it and other similar areas. 
The example below shows the original image on the left and the 
scanned image on the right.

1. Repeat the scan or copy with Background color removal set to 
Off, or if copying, select Image as the content type. See “Scan 
Settings Available” on page 4-21 and “Copy Settings” on 
page 4-34.

2. If the problem persists, clean and calibrate the scanner as indicated 
in “Clean the Scan Bars” on page 5-16 and “Calibrate the 
Scanner” on page 5-18. 

3. Repeat again with Background color removal set to Off.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Grain in area fills when scanning 
plain paper

When making copies of an original containing area fills, if the 
paper used in the printer is plain paper (e.g., Universal Bond or 
Bright White Inkjet Bond), some grain may appear in the image. 
This error may also appear in scanned files of originals that were 
printed on textured paper. The example shows the original image 
on the left and the scanned, grainy image on the right.

1. Check the original for dirt or fingerprints, or if the grain is 
already present in the print. If not, then go to step 2.

2. If original is a copy, repeat the copy after setting the content 
type to Image.

3. If the problem persists and the problem appears:
• when copying, use Best quality. We recommend using coated or 

glossy paper to avoid grain in copies.
• in a scanned file, scan at a lower resolution (300 dpi or lower).

4. If the problem continues, clean and calibrate the scanner as 
indicated in “Clean the Scan Bars” on page 5-16 and “Calibrate 
the Scanner” on page 5-18. 

5. Check that the maintenance sheet is clean, and is not 
damaged before calibrating the scanner (an old or damaged 
maintenance sheet may cause this problem); if it is damaged, 
reprint it as explained in Calibrate the scanner (see “Calibrate 
the Scanner” on page 5-18).

6. If the problem persists, analyze areas I and J of the diagnostic 
plot across modules =, 1 and 3. In the three examples, the top 
example is ideal, the middle example is acceptable; but, if you 
see something similar to the bottom example (or worse), 
contact your VariQuest dealer and report “grain in area fills.”

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Small color differences between 
adjacent scan bars.

When scanning wide plots, slightly different colors can sometimes 
be seen at both sides of the junction between two scan bars. This 
issue, if present, can be easily seen by analyzing patterns A and G 
of the diagnostic plot at the intersection between scan bars (see 
the examples). Note the black arrow indicating the scanning 
direction in these examples.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Large color differences between 
adjacent scan bars.

Sometimes the color mismatch between adjacent modules can be 
significant, showing a serious scanner malfunction (see example). 

If this occurs, see “Completely wrong colors.” on page 6-50.
1. Reboot the scanner and repeat the scan or copy. 
2. If the problem persists, repeat the scan or copy, setting the 

background color removal to Off or turning the original 90 
degrees before scanning it again.

3. If the problem continues, clean and calibrate the scanner as 
indicated in “Clean the Scan Bars” on page 5-16 and “Calibrate 
the Scanner” on page 5-18. 

• If calibration ended without errors, try to scan or copy again.
4. If the problem persists, analyze patterns A and G in the 

diagnostic plot. 
• If you see color differences between left and right sides of the bars 

for neutral and vivid colors, contact your VariQuest dealer and 
report “small color differences between adjacent scan bars.” 

• If you see color differences for vivid colors but not for neutral 
colors, see “Clipping in dark or light areas.” on page 6-44. See 
also “Grain in area fills when scanning plain paper” on page 6-
37.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Vertical light lines at intersection 
between scanner scan bars.

When scanning large uniform area fills that are made of some light 
color, sometimes light vertical bands (~ 0.5 cm wide) occur at the 
intersection between two scan bars (see example). Note the black 
arrow indicating the scanning direction.

1. Reboot the printer and set the background color removal to 
Off or turn the original 90 degrees, then scan or copy again.

2. If the problem persists:
• clean and calibrate the scanner as indicated in “Clean the Scan 

Bars” on page 5-16 and “Calibrate the Scanner” on page 5-18. 
• analyze pattern number B of the diagnostic plot at the 

intersections between scan bars. The example shows a good 
result on the left and a bad result on the right: the latter has light 
vertical banding 0.5 cm wide at the intersection between two scan 
bars.

If you see the kind of result shown, contact your VariQuest dealer 
and report “vertical light bands in area fills at the intersection 
between scan bars, after calibrating the scanner”. 

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Variable line thickness or missing 
lines.

When scanning some CAD plots at low resolution (mostly when 
working with grey scale or black-and-white prints that contain very 
thin lines), you may see a variation in line thickness, or even some 
missing lines, in some places.

1. Repeat the scan or copy using a higher resolution (600 dpi). 
- Scans: Set Background color removal to Off.
- Copies: Set content type to Mixed. 
- You should also deactivate the automatic de-skew as 

explained in “A copied or scanned image is very skewed” on 
page 6-54. 

- If working in black-and-white mode, try using grey scale.
2. If the problem persists, turn the original plot 90 degrees before 

scanning it again.
3. If the problem continues, clean and calibrate the scanner as 

indicated in “Clean the Scan Bars” on page 5-16 and “Calibrate 
the Scanner” on page 5-18.

4. If the problem continues, see “Defocus, blurring and fading 
colors.” on page 6-47.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Inaccurately produced colors. You have to deal with several variables if you want perfect color 
matching between the original you are scanning and the copy or 
scanned file you obtain as a result. Follow these guidelines if you 
find undesired colors as in the example (original on left, scanned 
image on right).

1. Consider your originals:
• Copies: Good color matching between a given original and its 

copy can be achieved only if both are printed on the same type of 
paper. 

• Scans: Good color matching can be achieved only if your monitor 
is color-calibrated or compliant with sRGB or AdobeRGB 
standards.

2. Reboot the printer and scan or copy again.
3. If the above conditions are met, consider that various scanner 

settings can affect the final color result (see “Scan Settings 
Available” on page 4-21 and “Copy Settings” on page 4-34). 
To obtain the best possible colors, set:

• Darker/Lighter = Normal
• Background color and noise removal = Off
• Content Type = Image (only if copying)
• Translucent Media = not selected. 

4. For optimum color results, clean the scan bars (see “Clean the 
Scan Bars” on page 5-16 and “Calibrate the Scanner” on 
page 5-18).

5. Avoid placing scanner in direct sunlight or near sources of 
heat or cold.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Color fringing. Color fringing occurs when the scanner is affected by incorrect 
paper advance and/or miscalibration. (some color fringing is 
unavoidable, especially at high scanning speeds). Fringing is most 
noticeable at the borders of sharp black text over a white 
background, as in the example (original on left, scanned image on 
right). Note the black arrow indicating the scanning direction.

1. Repeat the scan after changing the following:
• Scan: Increase resolution (300dpi or higher quality)
• Copy: Best resolution
• Turn original 90 degrees, if possible.

2. If the problem persists, clean and calibrate the scanner as 
indicated in “Clean the Scan Bars” on page 5-16 and “Calibrate 
the Scanner” on page 5-18.

3. If the problem still persists, analyze the E patterns of the 
diagnostic plot. The black horizontal lines appear slightly 
colored at the top and bottom of each end (example on right). 
Normally, they look red at the top and blue or green at the 
bottom, but it could be the other way around.

4. If you see this effect, contact your VariQuest dealer and report 
“color fringing problem after calibration.”

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Clipping in dark or light areas. Scanned file or copy of your plots loses detail in light or dark areas 
(or both). See example (original on left, scanned image on right).

1. If making copies with an original printed on photographic 
paper and you are copying onto matte paper, this problem is 
expected. However, you can try the following to improve 
quality:
- Reboot the printer.
- Set Background color and Noise removal to Off 
- Change Lighter/Darker settings (this also applies if 

experiencing this problem in scanned files).
2. If the problem persists, repeat the scan or copy using a higher 

resolution:
- Scan: 300 dpi or higher
- Copy: Normal or Best, Content type to Image

3. If problem persists, recalibrate scanner as indicated in 
“Calibrate the Scanner” on page 5-18. Clean the maintenance 
sheet and check that it is ot damaged before calibrating the 
scanner (if so, reprint as described in “Scanner Diagnostic 
Plot” on page 6-55. Re-scan after calibration is completed.

4. If problem persists, analyze patterns M (0, 1 and 2 modules) of 
the diagnostic plot. If you can distinguish lightness steps 
beyond the upper and lower specified thresholds, the scanner 
is fine. Examples show correct and incorrect functioning.

5. If the scanned pattern looks like the one on the right 
(incorrect), whether clipping is in dark and/or light areas, 
contact your VariQuest dealer and report “Clipping in dark/light 
areas.”

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Flare in the image when scanning 
glossy originals.

If the scanner is miscalibrated or if the original plot is very glossy 
or reflective, you can sometimes find flare in the scanned image 
(original on left, scanned image on right).

1. Clean the original and the scanner’s glass plate, then scan 
again. See “Clean the Scan Bars” on page 5-16.

2. If the problem persists, recalibrate the scanner as indicated in 
“Calibrate the Scanner” on page 5-18. Re-scan original after 
calibration is completed.

3. If the problem persists, see “Clipping in dark or light areas.” on 
page 6-44.

Vertical red and green bands over 
white or black background

If the scanner has not been calibrated for a long period of time, or 
if the last calibration failed, you can sometimes see defects 
(original on left, scanned image on right). Note the black arrow 
indicating the scanning direction. 

1. Reboot the printer and re-scan or copy. 
2. Clean and calibrate the scanner as indicated in “Clean the 

Scan Bars” on page 5-16 and “Calibrate the Scanner” on 
page 5-18. 

3. If calibration failed, see “Calibrate the Scanner” on page 5-18. 
If calibration ended correctly, scan original again and check 
that the colored vertical bands have disappeared.

4. If the problem persists, contact your VariQuest dealer and 
report “vertical red/green bands after calibration.”

Copy and Scan Quality Issues (Continued)
Problem Suggested Action

Image © www.convincingblack.com, reproduced with permission.
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Vibration If the printer is not properly placed on a flat surface or if the 
scanner lid does not close correctly, you may sometimes find that 
the scanned image suffers from vibration (original on left, scanned 
image on right).

1. Place the scanner on a flat surface and close the scanner lid 
correctly. Rescan the original.

2. If the problem persists, change (increase or decrease) the 
scanning resolution and re-scan the original. If possible, turn 
the original 90 degrees before rescanning.

3. If the problem persists, analyze pattern D of the diagnostic 
plot. If you see the problem shown on the right, contact your 
VariQuest dealer and report a “vibration problem.” 

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Defocus, blurring and fading 
colors.

CIS technology scanners are tuned to work at a fixed focal 
distance and are very sensitive to small variations in the position of 
the original with respect to the scanner glass plate. If the scanner 
lid is not properly closed or if the original has deep wrinkles or 
texture, you may sometimes find problems as in the example (on 
right), where the scanned image is blurred and colors are faded.

1. Check the scanner lid is properly closed. Open and close the 
scanner lid by pushing it down until you hear a click. Then 
calibrate the scanner as indicated in “Clean the Scan Bars” on 
page 5-16, reboot and repeat the scan.

2. If the problem persists, repeat with these settings:
- Scan: Resolution of 300dpi or higher, Background color 

removal Off
- Copy: Resolution Normal or Best, content type Mixed

3. If the problem persists, analyze pattern F in modules 0, 1 and 
2 of the diagnostic plot. A correct example is shown (right), 
followed by two incorrect examples. 

Note: There is a black ring near the center of pattern F. In this step, 
you must look at the region near the black ring. 

4. If you can see discontinuities in the black and white lines, 
contact your VariQuest dealer and report a “defocus or 
blurring” error.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Incorrect paper advance, skew 
during scanning, or horizontal 
wrinkles

You may encounter problems with some thick glossy originals 
moving through the scanner’s paper path and/or the original may 
become skewed during the scanning process.
If some paper rollers are not working correctly, the paper may get 
stuck in some regions and not in others. As a result, you may find 
small horizontal wrinkles in the scanned image. 
1. Turn your original 90 degrees and repeat your scan.
2. If the problem persists:

- Open the scanner lid. 
- Clean the feed wheels (small black rubber) and the pressure 

sliders (wide white plastic). 
- If you find dust particles or objects that obstruct movement of 

the pressure sliders, try to remove them.
- Close the scanner lid and repeat the scan.

3. If the problem persists, restart the scanner by turning it off and 
on again. If an error message displays during the operation, 
contact your VariQuest dealer and report the error message. If 
no error message displays, repeat the scan.

4. If the problem persists, analyze patterns D, K and L of the diagnostic 
plot. The plot should look like this:

5. If you see an image resembling the incorrect examples below, 
contact your VariQuest dealer and report an “incorrect paper 
advance” problem.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Vertical black band 30cm wide. The scanner contains various scanner scan bars, each of which 
covers an area 30 cm (12 in) wide. If one of the modules fails and 
the scanner hardware check does not detect the failure, the 
scanned image or copy may have a black vertical band 
corresponding to the area covered by a single scan bar (see 
example on the right). Note the black arrow indicating the 
scanning direction.

1. Restart the scanner by turning it off and on again. If you find 
an error message displays, contact your VariQuest dealer and 
report the error message. If no error message displays, repeat 
the scan.

2. If the problem persists, recalibrate the scanner as indicated in 
“Calibrate the Scanner” on page 5-18. If this operation fails, 
contact your VariQuest dealer with the error code displayed on 
the front panel. If no error code displays, repeat the scan.

3. If the problem persists, contact your VariQuest dealer and 
report a “vertical black band 30 cm wide.” 

The scanner damages some 
originals.

This scanner may cause vertical scratches on inkjet originals on 
thick glossy paper. Very thin tracing paper or old originals may also 
be damaged. This is because CIS technology requires the original 
to be held down with high pressure to obtain accurate results and 
avoid blurring and defocus problems.
If the original you intend to scan is valuable, and if it belongs to 
one of the types described above (inkjet-printed, thick, glossy 
original or old/thin/tracing paper original), HP recommends using a 
CCD scanner.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action

Original Scan affected by a failing scanbar
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Completely wrong colors. If some of the LEDs used for illumination in the scanner scan bars 
are failing or the last calibration did not work correctly, although no 
error message was displayed, you may experience some 
completely wrong colors in your scanned images (see example, 
original left, scanned image on right).

1. Restart the scanner by turning it off and on again. If an error 
message displays during this operation, contact your 
VariQuest dealer and report the error message.

2. If no error message displays during the restart process, 
recalibrate the scanner, as indicated in “Calibrate the Scanner” 
on page 5-18. If some error message display, contact your 
VariQuest dealer and report the error, adding that it displayed 
after seeing “completely wrong colors in the scanned image.”

3. If calibration succeeded, reboot and repeat the scan and 
check the colors.

4. If the colors are still wrong, analyze the whole diagnostic 
sheet. Check for completely wrong colors in the area 
corresponding to just one of the scan bars (see figure). If so, 
contact your VariQuest dealer and report “completely wrong 
colors after calibration,” and report the letter of the scan bar 
that is failing (module A in the example).

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Vertical distortion. If the lid sensor of the scanner fails, the scanner cannot detect 
when the lid is open. As a result, you can start a scan and at some 
point find that the pressure sliders do not move the original 
through the scanner paper path. You may see images like the 
following when this happens (original on left, scanned image on 
right). Note the black arrow indicating the scanning direction.

1. Open and close the scanner lid by pushing it down until you 
hear a click. 

2. Repeat the scan and visually check that the original advances 
correctly through the scanner path. 

3. If original does not advance, contact your VariQuest dealer 
and report an “incorrect paper advance” error. 

Remember that the scanner is not intended to work with 
originals thicker than 0.75 mm (29 mil).

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Object replication (ghosting). This error very rarely appears in CIS scanners. However, you can 
occasionally find image defects like the following (original on left, 
scanned image on right).

1. Restart the printer. 
2. Calibrate the scanner, as indicated in “Calibrate the Scanner” 

on page 5-18.
3. Repeat the scan. 

- Turn the original 90 degrees, if possible before re-scanning.
- ModifyLighter/Darker setting.

4. If the problem persists, analyze pattern C, modules 0, 1 and 2, 
of the diagnostic plot. If you see the kind of error shown on the 
right, contact your VariQuest dealer and report an "object 
replication" issue. 

Copy and Scan Quality Issues (Continued)
Problem Suggested Action

Image © www.convincingblack.com, reproduced with permission.
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Clipping or incorrect scale factor 
when down-scaling in copies and 
prints

When doing copies or prints (from USB, Embedded Web Server, 
or printer driver), the scaling setting is available with various 
possible options. If experiencing problems related to border 
clipping, or it seems that the print has lost the scale-factor 
adjustment, read this section select the best value for future 
scaling settings.

• Custom (Precise scaling): The content of the original image is 
scaled by the percentage factor that you select. For example, in 
an original CAD image with a 1:100 scale, if you select a scale to 
50%, the printed plot will have an accurate scale of 1:200. 
Regardless, in down-scalings, when selecting a fixed percentage, 
some clipping of the marginal content of the plot may occur, as it 
is impossible for the printer cannot print up to the borders of the 
paper.

• Fit to (Scale to fit into page size): The content of the original 
image is scaled by the percentage necessary to make sure that 
all content is correctly printed and no clipping occurs. Regardless, 
in down-scalings, when selecting fit to page, the scale-factor 
adjustment may not be an integer divisor of the original. For 
example, in an original CAD plot with a 1:100 scale on A2 paper 
size, if you select a scale to fit on A3 paper size, the scaling factor 
will not be exactly 50% and the scale of the printed plot will not be 
1:200 exactly. However, the plot will be printed completely without 
clipping any content.

Incorrect edge detection, mostly 
when scanning tracing paper.

Tracing or translucent papers can be scanned with good results, 
although totally transparent papers are not supported. However, 
the resulting image may have extra margins or some clipping of 
the content in some situations when paper edge detection is not 
accurate. This may also happen when scanning plain paper if the 
glass plate is dirty. To avoid these undesired effects, follow these 
recommendations.

• Carefully clean the scanner’s glass plate and the original to be 
scanned with a cloth. 

• Turn the original 90 degrees if possible and re-scan it 

Note: Remember to select Translucent as the paper type at the 
scanner if your original is translucent.

• If the problem persists, calibrate your scanner, and re-scan your 
original afterwards.

• If the problem persists with translucent paper, attach a sheet of 
white paper to the back of the original to be scanned.

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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A copied or scanned image is 
very skewed

Originals are often loaded into the scanner with some degree of 
skew. To correct for this unavoidable problem, the scanner has a 
built-in automatic de-skew algorithm, which measures the skew in 
the original and rotates the scanned image so the result is 
perfectly straight. However, in some cases the de-skew algorithm 
may increase the skew rather than correcting it. In other cases, the 
skew is so bad that it cannot be automatically corrected.
1. To load the original with minimum skew, grasp the original at 

the left and right edges, with the image facing up. Avoid 
resting your hands or the original on the scanner's input tray. 

2. Push the original into the scanner insertion slot until you feel 
the whole top border of the original pressing against the 
scanner rubber rolls. The rolls will load the original after a 0.5 
second delay. Remove your hands from the original. If you are 
not happy with the way the scanner grabbed the original, you 
can touch  and try again.

3. You can deactive the automatic de-skew algorithm by touching 

, then Scan preferences or Copy preferences (you may 
want to deactivate it in one case but not in the other). You can 
also deactivate the automatic de-skew from the Settings 
button before every new scanner job. 

Copy and Scan Quality Issues (Continued)
Problem Suggested Action
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Scanner Diagnostic Plot

Scanner Diagnostic Plot

 

Paper Jams
Problem Suggested Action

Prepare printer and paper to print 
diagnostic sheet.

1. Turn on printer and wait until it is functioning. 
2. Select the paper on which the diagnostic plot is going to be 

printed (you can reuse the diagnostic plot any time in the 
future, if it is saved carefully). Ideally, the diagnostic plot should 
be printed on heavyweight paper. 

Note: Please do not use recycled or tracing paper to print this plot. 
The size of the diagnostic plot is 610 × 914 mm (24 × 36 in). It can 
be printed on any 914 mm (36 in) landscape or 610 mm (24 in) 
portrait paper roll. You can also use a single sheet that is at least 
610 × 914 mm (24 × 36 in).

3. From the front panel, touch .
4. Touch Internal prints > Scanner IQ plot or Image Quality 

Maintenance > Scanner IQ plot > Printer maintenance > 
Scanner Diagnostic.

Visual check for errors while 
printing diagnostic sheet.

Once the diagnostic plot is printed, the first step is to check that all 
the patterns included in it are correctly printed. The diagnostic plot, 
if printed correctly, should look like this:

Some common defects that may appear in a printed diagnostic 
plot are described in this section. If you find any of these problems, 
you should follow the recommended recovery procedure. See the 
“Troubleshooting Print Quality Issues” on page 6-14. 
Once the printer has been diagnosed and is working correctly, 
reprint the diagnostic sheet as described in “Prepare printer and 
paper to print diagnostic sheet.” on page 6-55.
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Resolution By looking at pattern F you may find problems with the printer’s 
resolution for the loaded paper. Usually, this test does not reveal a 
printer problem, but a defect in the paper, which may not be 
suitable for printing the diagnostic sheet with the required quality.
The following example shows a correct resolution. Two defective 
examples follow. 

Paper Jams (Continued)
Problem Suggested Action
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Alignment Looking at patterns D, K, and L, you may find problems with the 
printer’s printhead alignment, which can cause defects such as the 
following.

Misalignment problems is visible in patterns D and G in the form of 
color fringing (which is exaggerated below, on the right). That is, 
the limits between two strong colors are not well defined or a third 
color appears between them.

Finally, a special pattern for checking the printer’s printhead 
alignment is located at the top left of the diagnostic sheet. This 
pattern has no number as it is not used for scanner checking. It is 
made of three colored crosses that may be used to identify the 
problem in question. The correct pattern is shown on the left, an 
example of misalignment on the right. 

Paper Jams (Continued)
Problem Suggested Action
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Loss of shadow or highlight 
details.

Looking at pattern H, you may find a problem with the printer or the 
paper. If you can distinguish lightness steps beyond the upper and 
lower specified thresholds, then the printer is fine. Here you can 
see examples of correct functioning on the left, incorrect on the 
right.

If the printer does not pass this test, check that you have correctly 
selected the paper type and the Best quality.

Printer banding. Patterns A, B, and C show vertical banding problems. See 
“Horizontal lines across the image.” on page 6-15.

Paper Jams (Continued)
Problem Suggested Action
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Streaks Patterns A, B, C, G and H show examples of vertical streaks. This 
occurs if the printer’s printheads are not working correctly. 
Replacing the printhead for the color showing the streaks may 
solve the problem. 

Grain Patterns A, B, and C, displays examples of problems in the 
printer’s paper advance or the printheads that cause visible grain 
in area fills. The following examples show this defect (originals on 
left, printed images on right).

Paper Jams (Continued)
Problem Suggested Action
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Scan or copy the diagnostic plot. There are two options for evaluating the diagnostic plot: scanning 
into a JPEG file, or copying onto paper. We recommend using the 
scan option, so the generated file can be analyzed more easily by 
a remote support engineer if necessary. 
To scan: Adjust your computer’s monitor as described in “Monitor 
calibration.” on page 6-61. Once you have scanned the diagnostic 
plot, open the scanned file in any image viewer software and 
select a zoom of 100% for correct visual evaluation of patterns.
To copy: Make sure that a paper roll at least 36 in. (914 mm) wide 
is loaded in the printer. Ideally, the same type of paper used to 
print the diagnostic plot should be used for copying it.
Use the following settings:
Scan

• Resolution: 600 dpi
• File type: JPG
• Compression: Medium
• Paper type: Photo or matte, according to the paper used to print 

the diagnostic plot. Use photo if in doubt.
Copy
• Content type: Image
Load the diagnostic plot into the scanner input tray with printed 
side up. The black arrows on the diagnostic plot indicate the 
direction of loading. Make sure the diagnostic plot is loaded 
without skew and it is centered (i.e., it covers the whole scanner 
area).
Once you have scanned the diagnostic plot (if using the scan 
option), open the scanned file in any image viewer software and 
select a zoom of 100% for correct visual evaluation of patterns. 

Paper Jams (Continued)
Problem Suggested Action
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Monitor calibration. The monitor on which the plot is going to be evaluated should 
ideally be calibrated. As this is not always possible, follow this 
easy procedure for adjusting the brightness and contrast of the 
monitor to see the patterns correctly.
Adjust the brightness and contrast of your monitor until you can 
see a difference in lightness between these two squares:

Now you are ready to check each pattern individually. 
Save the diagnostic plot for future 
use.

We recommend that you save the diagnostic plot for future use.

Paper Jams (Continued)
Problem Suggested Action
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Troubleshooting Ink Cartridge and Printhead 
Issues

Cannot Insert Ink Cartridge
Problem Suggested Action

Ink cartridge cannot be inserted 
into the printer.

1. Check that you have the correct type of cartridge (model 
number).

2. Check that the colored label on the cartridge is the same color 
as the label on the slot.

3. Check that the cartridge is correctly oriented, with the letter or 
letters marking the cartridge label right-side up and readable.
Never clean inside the ink cartridge slots.

Ink Cartridge Status Message
Message Description

OK • The cartridge is working normally, with no known problems.

Missing or Damaged • There is no cartridge present, or it is not correctly connected to the 
printer (shown with an X on the status screen).

Low: • The ink level is low.
Out of ink • The cartridge is empty.
Not genuine HP • The cartridge is not a genuine cartridge.
Wrong slot • The cartridge has been inserted into the wrong slot.
Incompatible • The cartridge is incompatible with this printer.
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Cannot Insert Printhead
Problem Suggested Action

Printhead cannot be inserted into 
the printer.

1. Check that you have the correct type of printhead (model 
number).

2. Check that you have removed the orange protective cap from 
the printhead.

3. Check that the printhead is correctly oriented.

4. Check that you have correctly latched the printhead, see 
“Replacing the Printhead” on page 5-9.

Cannot connect tubes to the 
printhead.

Check that the printhead is correctly inserted. See “Printhead 
cannot be inserted into the printer.” on page 6-63.

Check that the tubes connector lever (blue) is up before 
connecting the tubes connector. 
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Troubleshooting Data Communication Issues

Communication Failures between Computer and Printer
Symptom Suggested Action

• Front-panel display does not 
show the Printing message 
when an image is sent to the 
printer.

• Computer displays an error 
message when trying to print.

• Computer or printer hangs 
(stays idle), while 
communication is taking 
place.

• Printed output shows random 
or inexplicable errors 
(misplaced lines, partial 
graphics etc.).

• Check that the correct printer is selected in your application, see 
“Printing” on page 4-1.

• Check that the printer prints from other applications.
• Remember large prints take time to receive, process and print.
• Check the printer network connectivity status: the printer’s IP 

address should match the IP address specified in the printing 
computer. If addresses do not match, configure correctly; if the 
issue persists, check your network configuration.

• Try another interface cable.
• If the printer is connected to a wireless network, request a 

diagnostic report: press , then touch Print Details. Also try 
moving the printer closer to the wireless router, or connecting the 
printer by wired network.

When a network device automatically configures itself by receiving 
an IP address from the DHCP service, the IP address may change 
if the device is powered off and then on again. To avoid having the 
device shown as "offline:"

• Increase the lease time of your DHCP server device.
• Set a fixed IP address for your printer that will not be changed by 

DHCP.
• Configure the printer and driver to refer to the hostname instead 

of the numeric IP address.
To set a fixed IP address for the printer:
1. From the front panel, swipe down on the dashboard, then 

touch  or .
2. At the bottom of the screen, press Settings > Advanced 

setup > IP settings.
3. Enter the IP address, subnet mask, and gateway (settings 

should be provided by your network administrator).
To use the hostname instead of the numeric IP address:
1. Swipe down the front panel and note the IP address and 

hostname (HPXXXXXX format).
2. From PC, go to Control Panel > Printers, right-click the 

printer and select Properties > Ports > Configure Port, and 
in the Printer name or IP address field enter the hostname.
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Wired Network Issues
Problem Suggested Action

Unable to install the software 
provided with the printer.

Check that:
• All cable connections to the computer and the printer are secure.
• The network is operational and the network hub is turned on.
• All applications, including virus protection programs, spyware 

protection programs, and firewalls are closed or disabled for 
computers running Windows.

• The printer is installed on the same subnet as the computers that 
use the printer.

If the installation program cannot discover the printer:
• Print the network configuration page.
• Enter the IP address manually in the installation program. For 

more information, see “Configure Network Settings” on page 2-
22.

Note: Though it is not recommended that you assign a static IP 
address to the printer, you might resolve some installation problems 
(such as a conflict with a personal firewall) by doing so. See 
“Troubleshooting Data Communication Issues” on page 6-64.

Network port does not match the 
IP address of the printer.

Make sure that the network ports created in the printer driver 
match the printer's IP address.
1. Print the printer’s network configuration page.
2. Click Start > Settings > Printers or Printers and Faxes.

- or -
Click Start > Control Panel, then double-click Printers.

3. Right-click the printer icon, click Properties, then click the 
Ports tab.

4. Select the TCP/IP port for the printer, and then click 
Configure Port.

5. Verify the IP address listed in the dialog box with the IP 
address listed on the network configuration page. If the IP 
addresses are different, change the IP address in the dialog 
box to match the address on the network configuration page.

6. Click OK twice to save the settings and close the dialog boxes.
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Wireless Network Issues
Problem Suggested Action

Cannot connect wirelessly.
This printer supports 2.4 GHz 
Wireless connection. 5 GHz is not 
supported.

1.  Make sure the wireless (802.11) light at the top left of the front 
panel is turned on . If the blue light is not lit, the wireless 
capabilities may not have been turned on. To turn on wireless, 

press , then Wireless Settings > Wireless > On.
2. Disconnect the Ethernet cable, if connected to the printer. 

Connecting an Ethernet cable turns off the printer's wireless 
capabilities.

3. Restart components of the wireless network. Turn off the router 
and the printer, then turn them back on in this order: 1) Router, 
then 2) Printer. If you still are unable to connect, turn off the 
router, printer, and your computer. Sometimes, turning off the 
power and then turning it back on can solve a network 
communication issue.

4. Run the Wireless Network Test. To print a Wireless Network 

Test page, swipe down on the dashboard, then touch , then 
Settings > Print Wireless Network Test. If a problem is 
detected, the printed test report includes recommendations 
that could help to solve the problem.
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Advanced Wireless Network 
Troubleshooting: Problems 
persist even after trying 
suggested actions.

If you have tried the previous suggestions and are still unable to 
connect to your printer to the wireless network, try the following:
1. Make sure your computer's wireless networking has been 

turned on. For more information, see the documentation that 
came with your computer.

2. If you are not using a unique network name (SSID), then it is 
possible that your computer could be connected to a nearby 
network that is not yours. Try the following to determine 
whether your computer is connected to your network.
- Click Start > Control Panel, point to Network 

Connections, then click View Network Status and Tasks.
- or -

Click Start > Settings > Control Panel, double-click Network 
Connections, click the View menu, then select Details.
- Leave the network dialog box open while you continue to the 

next step.
- Disconnect power cord from the wireless router. The 

connection status of your computer should change to Not 
Connected.

- Reconnect power cord to the wireless router. The connection 
status should change to Connected.

Note: For more detailed information about your AirPort connection, 
click System Preferences in the Dock, then click Network. If the 
wireless connection is working correctly, a green dot appears next 
to AirPort in the list of connections. For more information, click the 
Help button in the window.

• Print the printer's Wireless Configuration page (see “Configure 
Network Settings” on page 2-22). After the page prints, check 
the Network Status and URL. The Network Status is Ready if the 
printer is actively connected to a network. The URL is the network 
address assigned to the printer by your router; you need it to 
connect to the printer's Embedded Web Server.

• If you are still unable to get your computer connected to your 
network, contact your network administrator as there may be a 
hardware issue with your router or computer.

Wireless Network Issues
Problem Suggested Action
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3. If you have established that the computer and the printer both 
have active connections to a network, you can check whether 
they are on the same network by trying to access the printer's 
Embedded Web Server (see “Access the Embedded Web 
Server” on page 2-18).
- If you cannot access the Embedded Web Server and are sure 

that both the computer and printer have active connections to 
the same network, the firewall security software could be 
blocking communication. Temporarily turn off any firewall 
security software running on your computer and try to access 
the Embedded Web Server again. If you can access it, try using 
the printer for printing.

- If you are able to access the Embedded Web Server and use 
your printer with the firewall turned off, you need to reconfigure 
your firewall settings to allow the computer and printer to 
communicate with each other over the network.

- If you are able to access the Embedded Web Server, but are 
still unable to use the printer even with the firewall turned off, try 
enabling the firewall software to recognize the printer. 

4. If you have the HP software installed, you can check the 
printer’s status from your computer to check whether the 
printer is paused or offline, preventing you from using it.
a. Click Start > Settings > Printers or Printers and Faxes.

- or -
Click Start > Control Panel, then double-click Printers.

b. If the printers on your computer are not displayed in Details 
view, click the View menu, then click Details.

c. Depending on the printer status, do one of the following:
* If the printer is Offline, right-click the printer, and click Use 

Printer Online.
* If printer is Paused, right-click the printer, and click Resume 

Printing.
d. Try using the printer over the network.

Wireless Network Issues
Problem Suggested Action
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If you install the HP software a second time, the installer may 
create a second version of the printer driver in your Printers or 
Printers and Faxes folder. If you have difficulties printing or 
connecting to the printer, make sure the correct version of the 
printer driver is set as the default.
1. Click Start > Settings then click Printers or Printers and 

Faxes.
- or -

Click Start > Control Panel, then double-click Printers.
2. Right-click the printer icon, then click Properties > Document 

Defaults, or Printing Preferences.
3. On the Ports tab, look for a port in the list with a checkmark. 

The version of the printer driver that is connected wirelessly 
has Standard TCP/IP Port as the Port description next to the 
checkmark.

4. Right-click the printer icon for the version of the printer driver 
that is connected wirelessly, and select Set as Default 
Printer.

5. Try restarting the HP Network Device Support service.
a. Delete any print jobs currently in the print queue.
b. On the desktop, right-click My Computer or Computer, 

then click Manage. 
c. Double-click Services and Applications, then click 

Services.
d. Scroll down the list of services, right-click HP Network 

Devices Support, then click Restart.
e. After the service restarts, try using the printer over the 

network again.

Note: If you are able to use the printer over the network, your 
network setup was successful.

Note: If you still cannot use the printer over the network, or if you 
have periodic problems in doing so, your firewall may be interfering, 
or there may be a problem with your network configuration or 
router. Contact the person who set up your network or the router 
manufacturer for help.

Wireless Network Issues
Problem Suggested Action
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Add Hardware Addresses to Wireless Access Point (WAP)

Add WAP Address
Problem Suggested Action

Need to add a hardware 
address(es) to a wireless access 
point (WAP).

MAC filtering is a security feature in which a WAP is configured 
with a list of MAC addresses (also called “hardware addresses”) of 
devices that are allowed to gain access to the network through the 
WAP. If the WAP does not have the hardware address of a device 
attempting to access the network, the WAP denies the device 
access to the network. If the WAP filters MAC addresses, then the 
printer’s MAC address must be added to the WAP’s list of 
accepted MAC addresses.
1. Print the network configuration page. For more information, 

see “Network Configuration Page Details” on page 6-72.
2. Open the WAP’s configuration utility, and add the printer’s 

hardware address to the list of accepted MAC addresses.
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Network Configuration Page
If the printer is connected to a network, you can print a network configuration page 
to view the network settings for the printer. You can use the network configuration 
page to help troubleshoot network connectivity problems. If you need to call HP, it 
is often useful to print this page before calling.

To print the network configuration page from the front panel:

1. Swipe down the dashboard, then touch .
2. Scroll down the menu, then touch Reports > Network Configuration Page.
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Network Configuration Page Details
Section Description

1. General Information Information about the current status and active connection type 
of the network, and other information, such as the URL of the 
Embedded Web Server.

2. 802.3 Wired Information about the active wired network connection, such as 
the IP address, subnet mask, default gateway, and hardware 
address of the printer.

3. 802.11 Wireless Information about your wireless network connection, such as 
the hostname, IP address, subnet mask, default gateway, and 
server.

4. Miscellaneous Information about more advanced network settings:
Port 9100: The printer supports raw IP printing through TCP 
Port 9100. This HP-proprietary TCP/IP port on the printer is the 
default port for printing. It is accessed by HP software.
Line Printer Daemon (LPD): Refers to the protocol and 
programs associated with line printer spooling services that 
may be installed on various TCP/IP systems.

Note: The LPD functionality can be used with any host 
implementation of LPD that complies with the RFC 1179 
document. The process for configuring printer spoolers, 
however, might differ. See your system documentation for 
information about configuring these systems.

Bonjour: Services (which use mDNS, or Multicast Domain 
Name System) are typically used on small networks for IP 
address and name resolution (through UDP port 5353), where 
a conventional DNS server is not used.
Service Location Protocol (SLP): An Internet standard 
network protocol that provides a framework to allow networking 
applications to discover the existence, location, and 
configuration of networked services in enterprise networks. 
This protocol simplifies discovery and use of network resources 
such as printers, Web servers, fax machines, video cameras, 
file systems, backup devices (tape drives), databases, 
directories, mail servers, and calendars.
Microsoft Web Services: Enable or disable the Microsoft Web 
Services Dynamic Discovery (WS Discovery) protocols or 
Microsoft Web Services for Devices (WSD) Print services 
supported on the printer. Disable unused print services to 
prevent access through those services.

Note: For more information about WS Discovery and WSD 
Print, visit http://www.microsoft.com/.
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SNMP (Simple Network Management Protocol): Used by 
network management applications for device management. 
The printer supports SNMPv1 protocol on IP networks. 
WINS: If you have a Dynamic Host Configuration Protocol 
(DHCP) server on your network, the printer automatically 
obtains its IP address from that server and registers its name 
with any RFC 1001 and 1002-compliant dynamic name 
services as long as a WINS server IP address has been 
specified.

5. Connected PC(s) Lists the computers connected to this printer, as well as the last 
time these computers accessed the printer.

Network Configuration Page Details
Section Description
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Troubleshooting General Printer Issues

General Printer Issues
Problem Suggested Action

The printer does not start. If the printer does not start (the front panel is blank), hold down the 
Power key for a few seconds and check whether the Power LED 
turns orange while the key is held down.

• If you see no orange light, no power is reaching the printer; check 
that the power cord is correctly plugged in. If the problem persists, 
contact your VariQuest dealer.

• If you see the orange light, wait for the printer to make a beeping 
sound.
- Three beeps or no beeps means that the front panel is broken; 

contact your VariQuest dealer.
- One long beep means an electronic problem; contact your 

VariQuest dealer.

The printer does not print. If all is in order (paper loaded, all ink components installed and no 
file errors), there are still reasons why a file you have sent from 
your computer may not start printing when expected:

• You may have an electrical power problem. If there is no activity 
at all from the printer, and the front panel does not respond, check 
that the power cord is connected correctly and that there is power 
available at the socket.

• You may be experiencing unusual electromagnetic phenomena, 
such as strong electromagnetic fields or severe electrical 
disturbances, which can cause the printer to behave strangely or 
even stop working. In this case, turn off the printer using the 
Power key on the front panel and unplug the power cord, wait until 
the electromagnetic environment has returned to normal, then 
turn it on again. If you still experience problems, please contact 
your VariQuest dealer.

• You may not have installed in your computer the correct driver for 
your printer, see the Assembly instructions.

• If you are printing on a sheet, you must specify Printer Autoselect 
or Single-Sheet or Multi-Sheet Tray as the paper source in your 
printer driver.



VariQuest® Perfecta® 2400STP User’s Guide 6-75

Troubleshooting General Printer Issues
Add Hardware Addresses to Wireless Access Point (WAP)

The printer seems slow. Check:
• That print-quality is set to Best or Max Detail. Best-quality and 

maximum detail prints take longer.
• That the correct paper type when loading the paper is specified. 

Some paper types require more time for printing; for example, 
photo and coated papers require more drying time between 
passes. To find out the printer's current paper type setting, see 
“View Paper Information” on page 3-13.

• If printer is connected by network, check that all components used 
in the network (network interface cards, hubs, routers, switches, 
cables) are capable of high-speed operation. Is there a lot of 
traffic from other devices on the network?

• If your printer is using a wireless network connection, try using a 
wired network or USB connection.

• You specified Extended drying time in the front panel. Try 
changing the drying time to Optimal.

The front panel is frozen. If the front panel displays a fixed image and you are unable to use 
it, call your VariQuest dealer for support.

Cannot access the embedded 
web server.

If you have not done so already, read “Access the Embedded Web 
Server” on page 2-18.

Note: If you connect directly to your printer with a USB cable, you 
cannot access the Embedded Web Server.

If you are using a proxy server, try bypassing the server and 
accessing the Web server directly.

• In Internet Explorer, go to Tools > Internet Options > 
Connections > LAN Settings, and check the Bypass proxy 
server for local addresses box. Alternatively, for more precise 
control, click the Advanced button and add the printer's IP 
address to the list of exceptions, for which the proxy server is not 
used.

• If you still cannot connect, switch the printer off and back on with 
the Power key on the front panel.

General Printer Issues (Continued)
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Alerts
Problem Suggested Action

By default, error alerts (critical alerts) are always displayed and warning alerts (non-critical alerts) are 
displayed only when you are printing. If alerts are enabled and there is a problem that prevents a job from 
completing, you see a pop-up window, which explains the reason for the problem. Follow the instructions 
to achieve your required result. Your printer can communicate two types of alerts.

Note: There are environments that do not support bidirectional communication. In those cases, alerts do 
not reach the job owner.

Errors Primarily alert you to the fact that the printer is unable to work 
normally. However, in the printer driver, even if the printer is able to 
print, errors can also alert you to conditions that could ruin the 
print, such as clipping.

Warnings Alert you when the printer needs attention either for an 
adjustment, such as a calibration or for a possible unprintable 
situation, such as a preventive maintenance or low ink. There are 
four different alerts communicators within your printer's system.

• Front-panel display: The front panel shows only the most 
relevant alert at a time. In the case of a warning, it disappears after 
a timeout. There are permanent alerts, such as "ink cartridge low 
on ink," that reappear when the printer becomes idle and there is 
not another more severe alert.

• Embedded Web Server: The upper-right corner of the 
Embedded Web Server window shows the printer status. If there 
is an alert in the printer, the status shows the alert text.

• Driver: The driver shows alerts about job configuration settings 
that may produce a problem in the final output. If the printer is not 
ready to print, it displays a warning.

• HP Utility: If the HP Utility is installed, alerts can be automatically 
displayed: a new panel opens on your screen with a list of alerts 
for each printer by the Alerts Settings in the HP Designjet Utility. 
You can also see the list of active alerts in the Overview tab of the 
HP Designjet Utility for Windows.
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Front Panel Error Messages
Occasionally you may see one of the following messages appear on the front-
panel display. If so, please follow the advice in the Suggested Action column.

Front Panel Error Messages
Message Suggested Action

[Color] cartridge is very low on ink. Ensure that you have a new cartridge of the same 
color ready. 

Depleted cartridges must be replaced to 
resume printing 

Replace the cartridges as needed. See “Replace 
Ink Cartridge” on page 5-3.

One or more cartridges appear to be missing 
or damaged. 

Insert cartridges of the correct color as needed. 
See “Replace Ink Cartridge” on page 5-3

Paper jam. See “Paper Loading Error Messages” on page 6-4.
Paper width is smaller than the minimum size 
supported by the selected paper source. Load 
canceled.

Remove the paper and load paper of the correct 
size.

Loaded paper is too wide. Manual unload 
required.

Remove the paper manually and load paper of the 
correct size.

Paper too far from lateral load line. Please try 
again.

Remove and reload the paper.

Please manually unload roll paper and try 
again. 

Rewind the roll manually.

Single sheet is loaded with too much skew. 
Please eject to unload the paper.

Remove and reload the paper.

The current job has been cancelled because 
the roll is out of paper. Load the roll and send 
the job again.

Load a new roll.

You are printing a multipage job. Load another 
sheet to continue printing or cancel the job.

Load another single sheet.

Multi-sheet tray is out of paper. Load paper in 
multi-sheet tray and press OK to continue 
printing or cancel the job.

Load paper into the multi-sheet tray.

End of roll has been reached. It is not possible 
to load the roll. 

Load a new roll.
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Missing or failed printhead. Remove and reinsert the same printhead, or try 
cleaning the electrical connections. If necessary, 
insert a new printhead. See “Replacing the 
Printhead” on page 5-9.

Note: The error message does not permit returning 
to the home screen to start the printhead 
replacement. Instead, press Show more.

Refilled or depleted cartridge detected. Check the cartridge.
Used cartridges might not have enough ink to 
complete startup. Open ink door to replace the 
cartridges.

A new printhead has been inserted without a new 
set of ink cartridges. Replace the cartridges not 
marked as new. See “Replace Ink Cartridge” on 
page 5-3.

Wrong file format. The file format is incorrect or not supported. The 
printer cannot process the job, which will be 
discarded.

Out of memory. The printer cannot complete the job. Resend the 
job, selecting Send job as bitmap in the driver: go 
to the Advanced tab, then Document options > 
Printer features.

Scanner paper jam. Open scanner cover and clear the jam.
Scanner Dust detected. Clean the scanner.
Scanner Out of memory. Scan at a lower resolution and/or increase 

compression. 

Front Panel Error Messages (Continued)
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Numerical Error Codes
Error Code Suggested Action

0001 - 0001 Restart the printer.
0081 - 0008 There may be a paper or carriage jam. Check and 

clear the paper path if necessary.
0001 - 0082 The battery of the real-time clock has expired. 

Contact your VariQuest dealer.
0021 - 0059, 0021 - 0017 Service station error. There may be a paper or 

carriage jam. Clear and check the paper path, if 
necessary, and restart the printer.

0021 - 0161 Service station error. Restart the printer.
0041 - 0017, 0042 - 0117 There may be a paper or carriage jam. Check and 

clear the paper path if necessary.
0079 - 0000 Restart the printer. If the problem persists, update 

the firmware. See “Software Updates” on page 5-
15.

0085 - XXXX Feeding paper problem. Restart the printer.
0086 - 0008 There may be a paper or carriage jam. Check and 

clear the paper path if necessary. Also clean the 
carriage encoder strip.

0009 - XXXX Scanner error. Restart the printer.
For any other error code, restart the printer. If the 
problem persists contact HP Support 
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7 Printer Specifications

This chapter provides the specifications for the VariQuest® Perfecta® 2400STP Poster 
Design System. The following information is contained in this chapter:

• “Functional Specifications” on page 7-2
“Physical Specifications” on page 7-5

• “Memory Specifications” on page 7-5
• “Power Specifications” on page 7-5
• “Ecological Specifications” on page 7-5
• “Environmental Specifications” on page 7-6
• “Acoustic Specifications” on page 7-6
• “Wireless Frequency Bands” on page 7-6
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Functional Specifications
Your printer is a color inkjet printer designed for printing high-quality images on 
paper up to 24 inches or 36 inches wide. 

Ink Supplies
Name Description

Printhead One printhead

Ink 
cartridges 

Cartridges containing 69 ml of ink: black, yellow, cyan and magenta.

Paper Sizes
Name Minimum Maximum

Roll width 279 mm (11 in) 610 mm (24 in)

Roll length 46 m (150 feet)

Roll diameter 100 mm (3.9 in)

914 mm (36 in) roll weight 6.2 kg (14 lb)

Sheet width 210 mm (8.27 in) 610 mm (24 in)

Sheet length 279 mm (11 in) 1676 mm (66 in)

Paper thickness 0.3 mm (0.01 in)

Paper weight 60 g/m² 280 g/m² (220 g/m² in multi-sheet tray)

Multi-sheet stacking 5 mm height
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Printing Resolutions
Print Quality Maximum Detail Rendering 

Resolution (ppi)
Printing Resolution 

(dpi)
Best (glossy paper*) On

Off
1200 × 1200

600 × 600
2400 × 1200
1200 × 1200

Best (other papers) Off 600 × 600 1200 × 1200

Normal Off 600 × 600 1200 × 1200

Fast Off 600 × 600 1200 × 1200

Econofast Off 600 × 600 1200 × 1200

Margins
Margin Size

Top, right and left margins 5 mm (0.2 in)

Bottom margin (trailing edge) 5 mm (0.2 in) (roll and multi-sheet)
17 mm (0.67 in) (single sheet)

Mechanical Accuracy
±0.1% of the specified vector length or ±0.2 mm (whichever is greater) at 23°C (73°F), 50-60% relative 
humidity, on E/A0 printing material in Best or Normal mode with HP Matte Film roll feed.

Supported Graphics Languages
HP-GL/2 and HP RTL (Windows), CALS G4
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Mobile Printing Specifications
Mobile printing Yes, directly from both iOS with AirPrint and Android with HP 

Print Service Plugin

Mobile devices supported by HP 
Mobile printing

Smartphones and tablets

Supported operating systems iOS, Android, Windows

OS Versions iOS from 7.0 and Android from 4.4, Windows any

Connectivity requirements Printer and mobile device must use the same network

Supported file formats PDF, JPEG

Email Printing Specifications
Mobile devices supported Smartphones, tablets, PC

Supported operating systems Any, as long as it has email

Connectivity requirements Cloud connection

Cloud features Remote printing through email

Supported file formats PDF, JPEG, TIFF

Max file size 10 MB

HP All-in-One Printing Remote App Specifications
Printing app HP All-in-One Printer Remote app

Mobile devices supported Smartphones, tablets, PC

Supported operating systems iOS and Android

OS versions iOS from 7.0 and Android from 4.4

Connectivity requirements Printer and mobile device must use the same network

Supported file formats PDF, JPEG and also can be printed web pages, email 
attachments, Microsoft Office documents
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Physical Specifications 

Memory Specifications 

Power Specifications 

Ecological Specifications 

Printer Physical Specifications
Minimum Maximum

Weight 62.5 kg (137.79 lb)

Width 1402.5 mm (55.22 in)

Depth 629.19 mm (24.77 in) 896 mm (35.3 in)

Height 966 mm (38.03 in) with stand
306 mm (12.05 in) without stand
1155mm (45.47 in) with trays open

1155 mm (45.47 in) 
306mm (12.05) without stand
Scanner open: 1060mm 41.73 in)
1155 mm (45.47) with trays open

Printer Memory Specifications
1 GB Memory

Printer Power Specifications
Specification Rating

Source 100–240 V ac ±10%, auto-ranging

Frequency 50/60 Hz

Maximum current 1200 mA

Average consumption 35 W

Printer Ecological Specifications
This product complies with WEEE Directive 2012/19/EU and RoHS Directive 2011/55/EU. To determine 
ENERGY STAR and EPAT registration status , go to http://www.hp.com/go/ecolabels.
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Environmental Specifications 

Acoustic Specifications 

Wireless Frequency Bands 

Printer Environmental Specifications
Specification Rating

Operating temperature 5 to 40°C (41 to 104°F)

Recommended operating temperature 15 to 35°C (59 to 95°F), depending on paper type

Storage temperature –25 to 55°C (–13 to 131°F)

Recommended operating humidity 20 to 80% RH, depending on paper type

Storage humidity 0 to 95% RH

Printer Acoustic Specifications
Specification Rating

Idle sound power level < 3.4 B (A)

Operating sound power level 6.5 B (A)

Idle sound pressure at bystander position  <16 dB (A)

Operating sound pressure at bystander position 48 dB (A)

Wireless Frequency Bands
The printer is identified to work in the wireless frequency band of: 2.4 GHz (802.11b/g/n)
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A Glossary

This chapter provides a description of some of the terms used in the VariQuest® 
Perfecta® 2400STP Poster Design System user guide.
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Glossary
Bonjour: Apple Computer's trade name for its implementation of the IETF 
Zeroconf specification framework, a computer network technology used in Apple's 
Mac OS X from version 10.2 onwards. It is used to discover services available on 
a local area network. It was originally known as Rendezvous.

Color accuracy: The ability to print colors that match the original image as closely 
as possible, bearing in mind that all devices have a limited color gamut and may 
not be physically capable of matching certain colors precisely.

Color consistency: The ability to print the same colors from a particular print job 
from print to print and from printer to printer.

Color model: A system of representing colors by numbers, such as RGB or 
CMYK.

Color space: A color model in which each color is represented by a specific set of 
numbers. Many different color spaces can use the same color model: for instance, 
monitors generally use the RGB color model, but they have different color spaces, 
because a particular set of RGB numbers results in different colors on different 
monitors.

Cutter: A printer component that slides back and forth across the platen to cut the 
paper.

ESD: ElectroStatic Discharge. Static electricity is common in daily life. It is the 
spark when touching the car door, or the cling of clothing. Although controlled 
static electricity has some useful applications, uncontrolled electrostatic 
discharges are one of the main hazards to electronic products. Therefore, to 
prevent damage some precautions are needed when setting up the printer, or 
handling ESD sensitive devices. This type of damage may reduce the life 
expectancy of the device. One way to minimize uncontrolled ESDs, and therefore 
reduce this type of damage is by touching any exposed grounded part of the 
printer (mainly metal parts) before handling ESD sensitive devices (such as the 
printhead or ink cartridges). Additionally, to reduce the generation of electrostatic 
charge in your body try to avoid working in a carpeted area, and keep your body 
movements to a minimum when handling ESD sensitive devices. Also, avoid 
working in low humidity environments.

Ethernet: A popular computer networking technology for local area networks.

Fast Ethernet: An Ethernet network capable of transferring data at up to 
100,000,000 bits/second. Fast Ethernet interfaces are capable of negotiating 
slower speeds when required for compatibility with older Ethernet devices.

Firmware: Software that controls your printer's functionality and is stored semi-
permanently in the printer (it can be updated).

Gamut: The range of colors and density values reproducible on an output device, 
such as a printer or monitor.
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Gigabyte Ethernet: An Ethernet network capable of transferring data at up to 
1000,000,000 bits/second. Fast Ethernet interfaces are capable of negotiating 
slower speeds when required for compatibility with older Ethernet devices.

Hi-Speed USB: A version of USB, sometimes called USB 2.0, that can run 40 
times faster than original USB, but is otherwise compatible with original USB. 
Most personal computers today use Hi-Speed USB.

HP RTL: Hewlett-Packard Raster Transfer Language: a language defined by HP 
to describe raster (bitmap) graphics.

HP-GL/2: Hewlett-Packard Graphics Language 2: a language defined by HP to 
describe vector graphics.

I/O: Input/Output: this term describes the passing of data between one device and 
another.

ICC: The International Color Consortium, a group of companies that have agreed 
on a common standard for color profiles.

Ink cartridge: A removable printer component that stores ink of a particular color 
and provides it to the printhead.

IP address: May mean an IPv4 address (most likely) or an IPv6 address.

IPSec: A sophisticated mechanism for providing network security by 
authenticating and encrypting IP packets sent between nodes on a network. Each 
network node (computer or device) has an IPSec configuration. Applications are 
usually unaware whether IPSec is being used or not.

IPv4 address: A unique identifier that identifies a particular node on an IPv4 
network. An IPv4 address consists of four integers separated by full stops. Most 
networks in the world use IPv4 addresses.

IPv6 address: A unique identifier that identifies a particular node on an IPv6 
network. An IPv6 address consists of up to 8 groups of hexadecimal digits 
separated by colons. Each groups contains up to 4 hexadecimal digits. Only a few 
new networks in the world use IPv6 addresses.

LED: Light-Emitting Diode: a semiconductor device that emits light when 
electrically stimulated.

MAC address: Media Access Control address: a unique identifier used to identify 
a particular device on a network. It is a lower-level identifier than the IP address. 
Thus, a device may have both a MAC address and an IP address.

Network: A network is a set of connections that pass data between computers 
and devices. Every device is able to communicate with every other device in the 
same network. This allows data to be moved between computers and devices, 
and allows devices such as printers to be shared between many computers.

Nozzle: One of many tiny holes in a printhead through which ink is deposited onto 
the paper.

Paper: A thin, flat material made to be written or printed on; most commonly made 
from fibers of some kind which are pulped, dried and pressed.
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Platen: The flat surface within the printer over which the paper passes while it is 
being printed on.

Printer driver: Software that converts a print job in a generalized format into data 
suitable for a particular printer.

Printhead: A removable printer component that takes ink of one or more colors 
from the corresponding ink cartridge(s) and deposits it on the paper, through a 
cluster of nozzles.

Spindle: A rod that supports a roll of paper while it is being used for printing.

TCP/IP: Transmission Control Protocol/Internet Protocol: the communications 
protocols on which the Internet is based.

USB: Universal Serial Bus: a standard serial bus designed to connect devices to 
computers. Your printer supports Hi-Speed USB (sometimes called USB 2.0).

USB device port: A square USB socket found on USB devices, though which a 
computer can control the device. For a computer to print to your printer using a 
USB connection, the computer must be connected to the printer's USB device 
port.

USB host port: A rectangular USB socket such as those on found on computers. 
A printer can control USB devices that are connected to such a port. Your printer 
has two USB host ports, which it uses to control accessories and USB flash drives.

WiFi: This term is used for any wireless local area network products that are 
based on the Institute of Electrical and Electronics Engineers' (IEEE) 802.11 
standards.
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